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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and
conditions of this legal disclaimer before you read or use this document. If you
have read or used this document, it shall be deemed as your total acceptance of this

legal disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website
or other Alibaba Cloud-authorized channels, and use this document for your
own legal business activities only. The content of this document is considered

confidential information of Alibaba Cloud. You shall strictly abide by the
confidentiality obligations. No part of this document shall be disclosed or
provided to any third party for use without the prior written consent of Alibaba
Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted
, or disseminated by any organization, company, or individual in any form or by
any means without the prior written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades
, adjustments, or other reasons. Alibaba Cloud reserves the right to modify
the content of this document without notice and the updated versions of this

document will be occasionally released through Alibaba Cloud-authorized
channels. You shall pay attention to the version changes of this document as they
occur and download and obtain the most up-to-date version of this document
from Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud

products and services. Alibaba Cloud provides the document in the context
that Alibaba Cloud products and services are provided on an "as is", "with all
faults" and "as available" basis. Alibaba Cloud makes every effort to provide
relevant operational guidance based on existing technologies. However, Alibaba
Cloud hereby makes a clear statement that it in no way guarantees the accuracy
, integrity, applicability, and reliability of the content of this document, either
explicitly or implicitly. Alibaba Cloud shall not bear any liability for any errors
or financial losses incurred by any organizations, companies, or individuals
arising from their download, use, or trust in this document. Alibaba Cloud shall

not, under any circumstances, bear responsibility for any indirect, consequent



ial, exemplary, incidental, special, or punitive damages, including lost profits
arising from the use or trust in this document, even if Alibaba Cloud has been
notified of the possibility of such a loss.

5. By law, all the contents in Alibaba Cloud documents, including but not limited
to pictures, architecture design, page layout, and text description, are intellectu
al property of Alibaba Cloud and/or its affiliates. This intellectual property
includes, but is not limited to, trademark rights, patent rights, copyrights, and
trade secrets. No part of this document shall be used, modified, reproduced,
publicly transmitted, changed, disseminated, distributed, or published without
the prior written consent of Alibaba Cloud and/or its affiliates. The names owned

by Alibaba Cloud shall not be used, published, or reproduced for marketing,
advertising, promotion, or other purposes without the prior written consent of
Alibaba Cloud. The names owned by Alibaba Cloud include, but are not limited
to, "Alibaba Cloud", "Aliyun", "HiChina", and other brands of Alibaba Cloud
and/or its affiliates, which appear separately or in combination, as well as the
auxiliary signs and patterns of the preceding brands, or anything similar to the
company names, trade names, trademarks, product or service names, domain
names, patterns, logos, marks, signs, or special descriptions that third parties

identify as Alibaba Cloud and/or its affiliates.

6. Please contact Alibaba Cloud directly if you discover any errors in this document
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Document conventions

Style Description Example
A danger notice indicates a
situation that will cause major Danger:
system changes, faults, physical | Resetting will result in the loss
injuries, and other adverse of user configuration data.
results.
A warning notice indicates a
situation that may cause major . Warning:
system changes, faults, physical | Restarting will cause business
injuries, and other adverse interruption. About 10
results. minutes are required to restart

an instance.
A caution notice indicates
warning information, Notice:
supplementary instructions, If the weight is set to 0, the
and other content that the user | server no longer receives new
must understand. requests.
A note indicates supplemental
instructions, best practices, tips Note:
, and other content. You can use Ctrl + A to select
all files.

> Closing angle brackets are used | Click Settings > Network > Set
to indicate a multi-level menu |network type.
cascade.

Bold Bold formatting is used for Click OK.
buttons, menus, page names,
and other Ul elements.

Courier font |Courier fontis used for Run the cd /d C:/window
commands. command to enter the Windows

system folder.

Italic Italic formatting is used for bae log list --instanceid

parameters and variables.
Instance_ID

[] or [a]|b] This format is used for an ipconfig [-all|-t]
optional value, where only one
item can be selected.




Style Description Example

{} or {a|b} This format is used for a switch {active|stand}
required value, where only one
item can be selected.
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1 Preface

This topic provides an overview of RDS for MySQL, including a disclaimer, terms,

and concepts.
Overview

Alibaba Cloud ApsaraDB for RDS (short for Relational Database Service) is a
stable, reliable, and scalable online database service. Based on Alibaba Cloud
distributed file system and high-performance SSD storage, ApsaraDB for RDS
supports the MySQL, SQL Server, PostgreSQL, and PPAS (compatible with Oracle)
database engines and provides a portfolio of solutions to disaster tolerance,
backup, recovery, monitoring, and migration to facilitate database operation and

maintenance. For information about the benefits of ApsaraDB for RDS, see #unique 4.

This document describes how to configure and manage RDS through the RDSconsole
, helping you better understand the features and functions of ApsaraDB for RDS.
Additionally, you can configure and manage RDS through API and SDK.

If you need technical support, you can call 95187. Alternatively, you can open the
RDSconsole and in the upper-right corner choose More > Support > Open a new
ticket. If your business is complex, you can purchase a support plan to obtain your
exclusive support service from IM enterprise groups, technical service managers

(TAM), and service managers.
For more information about ApsaraDB for RDS, visit ApsaraDB RDSfor MySQL.
Disclaimer

Some product features or services described in this document may be unavailable
for certain regions. See the relevant commercial contracts for specific Terms and
Conditions. This document serves as a user guide only. No content in this document

can constitute any express or implied warranty.
Terms

- Instance: A database service process that takes up physical memory independen
tly. You can specify the memory size, disk space, and database type of an

instance, but only the memory specification determines the performance of the


https://rds.console.aliyun.com/
https://rds.console.aliyun.com/
https://rds.console.aliyun.com/
https://rds.console.aliyun.com/
https://www.alibabacloud.com/support/after-sales
https://www.alibabacloud.com/product/apsaradb-for-rds

instance. After an instance is created, you can delete it or change its configurat
ion as needed.

- Database: A logical unit created in an instance. Multiple databases that each have
a unique name can be created in one instance.

- Region and zone: A region is a physical data center. A zone is a physical area that
has independent power supply and network in a region. For more information,
visit Alibaba Cloud's Global Infrastructure.

Concepts
Item Description
On-premises database A database that is deployed in your on-

premises equipment room or on a cloud
other than ApsaraDB for RDS.

RDS for XX (XX is MySQL, SQL Server, A type of RDS instance. For example
, RDS for MySQL refers to the type of
PostgreSQL, or PPAS.) RDS instance that runs in the MySQL

database engine.



https://www.alibabacloud.com/global-locations

2 Limits of RDS for PPAS

This topic describes the limits of RDS for PPAS. To guarantee stability and security,

you must understand the limits.

The following table describes the limits of common actions and configurations in

RDS for PPAS.

Operation

Description

Parameter modification

Currently not supported

Database root permission

RDS does not offer the superuser
permission to users.

Database backup

You can back up data only through
pg_dump.

Data migration to the cloud

You can only use psql to restore data
backed up by pg_dump.

Set up database replication

- You do not need to set up data
replication because the system has
automatically set up PPAS stream
replication based the HA mode.

- The PPAS slave node is invisible to
users, and cannot be used directly for
access.

Restart an RDS instance

You must restart an instance through
the RDSconsole or APIs.

Network settings

If the access mode of the instance is

safe connection mode, enabling
net.ipv4.tcp_timestamps in SNAT mode
is not allowed.



https://rds.console.aliyun.com/

3 Quick start

3.1 General workflow to use RDS for PPAS

This topic describes the general workflow for how to create and use an RDS for

PPAS instance.

If this is the first time that you use RDS for PPAS, read Limits of RDSfor PPASbhefore you

purchase an RDS for PPAS instance.

The following flowchart shows the general workflow.

Set whitelist

Create databasi

. Create an RDSfor PPAS instance.
. Configure a whitelist for the RDSfor PPASinstance.

. Apply for a public endpoint for the RDSfor PPASinstance.

. Create databases and accounts for the RDSfor PPAS instance.

G =~ W N -

. Connect to the RDSfor PPASinstance.



3.2 Create an RDS for PPAS instance

This topic describes how to create an RDS for PPAS instance through the RDS

console.

For information about how to create an RDS for MySQL instance by calling an API

action, see CreateDBInstance.

For information about the pricing of RDS for MySQL instances, see #unique_15.
Prerequisites

You have registered an Alibaba Cloud account.

For more information, see Sgn up with Alibaba Cloud.
Precautions

- Subscription instances cannot be converted to pay-as-you-go instances.

- Pay-as-you-go instances can be converted to subscription instances. For more
information, see Switch from pay-as-you-go billing to subscription billing.

- By default, each Alibaba Cloud account can create up to 30 pay-as-you-go RDS

instances. You can open aticket to apply for an increase to the limit.
Procedure

1. Log on to the RDSconsole.
2. On the Instances page, click Create Instance.

3. Select a billing method:

- Pay-As-You-Go: indicates post payment (billed by hour). For short-term
requirements, create pay-as-you-go instances because they can be released at
any time to save costs.

- Subscription: indicates prepayment. You must pay when creating an instance.
For long-term requirements, create subscription instances because they are
more cost-effective. Furthermore, the longer the subscription, the higher the

discount.


https://www.alibabacloud.com/help/doc-detail/50482.html
https://workorder-intl.console.aliyun.com/console.htm#/ticket/createIndex
https://rds.console.aliyun.com/?spm=5176.doc43185.2.7.mR2Syx

. Set the following parameters.

Parameter

Description

Region

Select the region in which the RDS instance to be purchased
will be located. The region cannot be changed after the
instance is created. We recommend that you:

- Select the same region as the corresponding ECS instance
to avoid incurring charges for Internet traffic usage and
guarantee fast access.

- Check whether the selected region supports your required
MySQL version and whether multi-zone support is available.

Database
Engine

Select a DB engine.
In this example, select MySQL.
Note:

The available DB engines vary depending on the region you
select.

Version

Select a version of MySQL. You can select MySQL 5.5, 5.6, 5.7, or
8.0.

Note:
The available versions vary depending on the region you
select.




Parameter

Description

Edition

Select an RDS edition. Valid values:

- Basic: The DB system has only one instance. In this edition,
computation is separated from storage, which is cost-
effective. However, we recommend that you do not use this
edition in production environments.

- High-availability: The DB system has two instances: one
master instance and one slave instance. The two instances
work in a classic high-availability architecture.

- Enterprise Edition: The DB system has three instances: one
master instance and two slave instances. The three instances
are located in three different zones in the same region to
guarantee service availability. This edition is available to the
China (Hangzhou), China (Shanghai), China (Shenzhen), and
China (Beijing) regions.

Note:
The available editions vary depending on the DB engine
version you select. For information about the RDS editions,
see #unique_17.

Storage Type

Select a storage type. Valid values:

- Local SSD: An SSD that is located on the same node as the DB
engine. Storing data to local SSDs reduces I/O latency.

- Standard SSD: An elastic block storage device that is
designed based on a distributed storage architecture. Storing
data to cloud SSDs makes separation between computation
and storage possible.

- Enhanced SSD: An SSD that is designed based on the new-
generation distributed block storage architecture and the
25 GB and RDMA technologies to reduce single-link latency.
Each enhanced SSD can process up to 1,000,000 random read
and write requests.

For more information, see #unique _18.




Parameter

Description

Zone

Select a zone.

A zone is a physical area within a region. Different zones in the
same region are basically the same. You can deploy the master

and slave instances in the same zone or in different zones.

Multi-zone deployment is more secure because it provides zone

-level disaster tolerance.

Network Type

Select a network type. Valid values:

- Classic Network: indicates a traditional network.

- VPC (recommended): short for Virtual Private Cloud. A VPC
is an isolated network environment and therefore provides
higher security and performance than a classic network.

Note:
Make sure the network type of the RDS instance is the same
as that of your ECS instance so that the ECS instance can
access the RDS instance through the intranet.

Type

Select an RDS instance type.

The RDS instance type specifies the specifications of the RDS
instance. Each type supports a specific number of CPU cores,
memory size, maximum number of connections, and maximum

IOPS. For more information, see #unique_19.

Valid values:

- General-purpose instance: provides dedicated memory and
I/0 resources, but shares the CPU and storage resources with
the other general-purpose instances on the same server.

- Dedicated instance: provides dedicated CPU, memory,
storage, and I/0 resources.

- Dedicated host: provides all the CPU, memory, storage, and I/
O resources on the server where it is located.
For example, 8 Cores 32 GB (Basic) indicates a general-purpose
instance, and 8 Cores 32 GB (Dedicated) indicates a dedicated

instance.




Parameter Description

Capacity The capacity is used for storing data, system files, binlog files,

and transaction files.

5. Optional. Set the duration of the billing method for a subscription instance and

specify the number of instances to be created. Then, click Buy Now.

Note:

For a subscription instance, you can:

- Select Auto Renew in the Duration section. Then the system can automatically
deduct fees to extend the validity period of the instance. For example, if you
purchase a three-month subscription instance with Auto Renew selected,
the system automatically deducts frees of three months when the instance is
about to expire.

- Click Add to Cart and then click the cart to place the order.

6. On the Order Confirmation page, read and confirm you agree to Terms of Service,
Service Level Agreement, and Terms of Use by selecting the checkbox, confirm

the order details, and click Pay Now.
What to do next

Log on to the RDSconsole, select the target region, and view the instance details.

u (-] Alibaba Cloud
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After the RDS instance is created, you must configure whitelists and create accounts for it. If
you want to connect to the RDS instance through the Internet, you must also apply for

a public endpoint for it. After all is done, you can connect to the RDSinstance.


https://rdsnext.console.aliyun.com

APIs

API Description

#unique_20 Used to create an RDS instance.

3.3 Configure a whitelist for an RDS for PPAS instance

This topic describes how to configure a whitelist for an RDS for PPAS instance.

After you create an RDS instance, you must configure a whitelist to allow external
devices to access the instance. The default whitelist contains only the default IP
address 127.0.0.1. Before you add new IP addresses to the whitelist, no devices can

access the RDS instance.

A whitelist can be used to improve the security of your RDS instance. We
recommend that you update the whitelist on a regular basis. Configuring a whitelist

does not affect the normal operation of your RDS instance.

Precautions

- The default whitelist can only be edited or cleared, but cannot be deleted.

- If you log on to DMS but your IP address has not been added to the whitelist,
DMS prompts you to add the address and automatically generates a whitelist
containing your IP address.

- You must confirm which network isolation mode the instance is in before
configuring a whitelist. Refer to the corresponding operations based on the

network isolation mode.

Basic Information

ases o -
PR Network isolation mode: standard whitelit. The following whitelsts contain IP addresses from both dassic networks and VPCs.
Edit Clear

127.0.0.1

Whitelist Settings Description



The internal networks to which RDS instances belong are divided into two types:

classic network and VPC.

- Classic network: Alibaba Cloud allocates IP addresses automatically. Users only
need to perform simple configurations. This network type is suitable for new
users.

- VPC: Users customize the network topology and IP addresses. It supports leased

line connection, and is suitable for advanced users.
Procedure
Enhanced whitelist

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.

: () AlibabaCloud  cnina (Hangzhou) « Q  BilingManagement More [J A ¢y  Englist "7

RDS instz
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Data Security.
5. On the Whitelist Settings tab page, follow the following instructions based on

your usage scenario:
- Accessing an RDS instance from an ECS located in a VPC: Click Edit next to the
default VPC whitelist.

- Accessing an RDS instance from an ECS located in a classic network: Click Edit

next to the default Classic Network whitelist.

- Accessing an RDS instance from an ECS or host located in a public network:
Click Edit next to the default Classic Network whitelist.

Note:


https://rds.console.aliyun.com/

- If the ECS instance accesses the RDS instance by using the VPC or classic
network, you must make sure that the two instances are in the same region

and have the same network type. Otherwise, the connection fails.

- You can also click Create Whitelist. In the displayed Create Whitelist dialog
box, select VPC or Classic Network/Public IP.

rvice Avalabily Security Group

.

6. Specify IP addresses or CIDR blocks used to access the instance, and then click
OK.

- If you specify the CIDR block 10.10.10.0/24, any IP addresses in the 10.10.10.X
format are allowed to access the RDS instance.
- To add multiple IP addresses or CIDR blocks, separate each entry with a

comma (without spaces), for example, 192.168.0.1,172.16.213.9.

- After you click Add Internal IP Addresses of ECS Instances, the IP addresses of
all the ECS instances under your Alibaba Cloud account are displayed. You can

quickly add internal IP addresses to the whitelist.

Note:
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After you add an IP address or CIDR block to the default whitelist, the default
address 127.0.0.1 is automatically deleted.

Edit Whitelist

Network Type: VPC ' Classic Network/Public IP
You currently cannot configure network isolation settings. You must
enable enhanced whitelists first before configuring network isolation
settings.

Whitelist Name™: default

Whitelist™*: 127.0.0.1

Add Internal IP Addresses of ECS Instances ]
You can add 999 more entries.

Spedified IP address: If you specify the IP address
192.168.0.1, this IP address is allowed to access the RDS
instance.

Spedified CIDR block: If you specify the CIDR block
192.168.0.0/24, the IP addresses ranging from 192.168.0.1 to
192.168.0.255 are allowed to access the RDS instance.

When you add multiple IP addresses or CIDR blocks, separate
them by a comma (no space after the comma), for example,
192.168.0.1,192.168.0.0/24.

How to Locate the Local IP Address

MNew whitelist entries take effect in 1 minute.

Standard whitelist

1. Log on to the RDSconsole.
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2. In the upper-left corner, select the region where the target RDS instance is
located.

= () Alibaba Cloud  cnina angzhou) « Q  ligansgement  More [ 4 @y egsn ()

RDS inste
ApsaraDB for RDS

RDS Mal

3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Data Security.
5. On the Whitelist Settings tab page, click Edit corresponding to the default
whitelist.
)
[:] Note:

You can also click Create Whitelist to configure a whitelist.

Whitelist Settings SQL Audit SSL Encryption

Network isolation mods: standard whitzlist. The following whitelists contain IP addresses from both classic networks and VPCs. Enable Enhanced Whitslist (Recommended)
e

127.0.0.1

Whitelist Settings Description

6. In the displayed Edit Whitelist dialog box, specify the IP addresses or CIDR

blocks used to access the instance, and then click OK.

- If you specify the CIDR block 10.10.10.0/24, any IP addresses in the 10.10.10.x
format are allowed to access the RDS instance.

- To add multiple IP addresses or CIDR blocks, separate each entry with a
comma (without spaces), for example, 192.168.0.1,172.16.213.9.

- After you click Add Internal IP Addresses of ECS Instances, the IP addresses of
all the ECS instances under your Alibaba Cloud account are displayed. You can
quickly add internal IP addresses to the whitelist.

3

[:] Note:



After you add an IP address or CIDR block to the default whitelist, the default
address 127.0.0.1 is automatically deleted.

Edit Whitelist

Network Type: WPC Classic Network/Public IP
You currently cannot configure network isolation settings. You must
enable enhanced whitelists first before configuring network isolation
settings.

Whitelist Name™: default

Whitelist™: 127.0.0.1

Add Internal IP Addresses of ECS Instances |
You can add 999 more entries.

How to Locate the Local IP Address

Common errors

- The default address 127.0.0.1 on the Whitelist Settings tab indicates that no
device is allowed to access the RDS instance. Therefore, you must add IP

addresses of devices to the whitelist to allow access to the instance.

- The IP address in the whitelist is set to 0.0.0.0, but the correct format is 0.0.0.0/0.

% Note:



0.0.0.0/0 indicates that all devices are allowed to access the RDS instance.

Exercise caution when using this IP address.

- If you turn on the enhanced whitelist mode, you must make sure that:

- If the network type is VPC, the internal IP address of the ECS instance is added

to the whitelist whose network isolation mode is VPC.

- If the network type is classic network, the internal IP address of the ECS
instance is added to the whitelist whose network isolation mode is classic
network.

- Ifyou are connecting to the RDS instance through ClassicLink, the internal IP
address of the ECS instance must be added to the default VPC whitelist.

- If you are connecting to the RDS instance through a public network, the
public IP address of the instance or host must be added to the whitelist whose
network isolation mode is classic network.

- The public IP address that you add to the whitelist may not be the real egress IP

address. The reasons are as follows:

- The public IP address is not fixed and may dynamically change.
- The tools or websites used to query the public IP addresses provide wrong IP

addresses.

For more information, see #unique 23

APIs
API Description
#unique_24 Used to view the IP address whitelist of
an RDS instance.
#unique 25 Used to modify the IP address whitelist
of an RDS instance.

3.4 Create databases and accounts for an RDS for PPAS instance

This topic describes how to create databases and accounts for an RDS for PPAS

instance.

Before using RDS, you must create databases and accounts for your RDS instance
. For PPAS instances, you must create a premier account in the RDS console. And

then you can create and manage databases through a client. This topic takes the


https://www.alibabacloud.com/help/zh/doc-detail/65412.htm

pgAdmin 4 client as an example to introduce how to create databases and accounts

for PPAS instances.
Precautions

- Databases under a single instance share all the resources of this instance. Each
PPAS instance supports one premier account, countless general accounts,

and countless databases. You must create and manage common accounts and
databases through SQL statements.

- To migrate your local database to an RDS instance, you must create the same
databases and accounts for the RDS instance as your local database.

- When assigning account permissions for each database, follow the minimum
permission' principle and consider service roles to create accounts. Alternativ
ely, rationally assign read-only and read/write permissions. When necessary,
you can split accounts and databases into smaller units so that each account can
only access data for its own services. If the account does not need to write data to

a database, assign the read-only permission for the account.
- For database security purposes, set strong passwords for the accounts and

change the passwords regularly.
Procedure

1. Log on to the RDSconsole.
2. Select the target region.

u (-] Alibaba Cloud

RDS instz
ApsaraDB for RDS

RDS Mai

*+ 1fEIBEEEEEEE

apan (Tokyo,

3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Accounts.

5. Click Create Initial Account.


https://rds.console.aliyun.com/

6. Enter the account information.

Accounts

Accounts

Create Acoount <« Back to Accounts

*Database Account:

*Password:

“Re-enter Password:

Cancel

Parameter description:

- Database Account: The name of the premier account. The account name must
be 2 to 16 characters in length and can contain lowercase letters, numbers,
and underscores (_). It must start with a letter and end with a letter or
number.

- Password: The password of the premier account. The account password must
be 8 to 32 characters in length and contain at least three of the following types
of characters: uppercase letters, lowercase letters, numbers, and special

characters. The allowed special characters are as follows:

'1@#$% A A&*()_+-=
- Re-enter Password: Enter the password again.
7. Click OK.
8. Add the IP address that is allowed to access the RDS instance to the RDS

whitelist. For more information, see Configure a whitelist for an RDSfor PPASinstance.

9. Start the pgAdmin 4 client.



10Right-click Servers and choose Create > Server from the shortcut menu.

W pgAdmin 4 E

A Browser & Dashboard &5 Properties B SQL |+ Statistics {3 Dependencies <3 Dependents

o 8 e

S

E Serer Group...
i Refresh F Serer..

& Properties .

PIAdmMIN ..

Management Tools for PostgreSQL

Feature rich | Maximises PostgreSQL | Open Source

pgAdmin is an open source administration and management tool for the PostgreSQL database. The tools include a graphical
administration interface, an SQL query tool, a procedural code debugger and much more. The tool is designed to answer the
needs of developers, DBAs and system administrators alike.

‘Quick Links

Add New Server Configure pgAdmin

Getting Started

W @ &
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111In the Create Server dialog box, click the General tab and enter the server name.

F Create - Server n
General Connection

Name

Server group | B Servers M
Connect now?

Comments

A
i ? Save | % Cancel & Reset

20 Issue: 20191127



12Click the Connection tab and enter the information about the RDS instance to be

connected.

F Create - Server B

General  Connection

Host | |
namefaddress

Maintenance postgres
database

Username | |

Password

Save |:|

password?

Role

SS5L mode Prefer j

'‘Port' must be greater than or equal to 1024.

Parameter description:

- Host name/address: The internal or public endpoint of the RDS instance. To
obtain the internal and public endpoints and ports of the RDS instance, follow

these steps:

a. Log on to the RDSconsole.
b. Select the target region.

c. Find the target RDS instance and click the instance ID.


https://rds.console.aliyun.com/

d. On the Basic Information page, find the Basic Information section, where
you can obtain the internal and public endpoints and ports of the RDS
instance.

- Port: The internal or public port numbr of the RDS instance.
- Username: The username of the premier account for the RDS instance.
- Password The password of the premier account for the RDS instance.
13Click Save.
141If the connection information is correct, choose Servers > server name >
Databases > edb or postgres. The following page is displayed, which indicates

that the connection to the RDS instance is successful.

@ Note:

postgres is the default system database of the RDS instance. Do not perform any

operation in this database.
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pgAdmin 4 - DB:postgres 2017-07-07 11:03:20 CST active no



15Double-click postgres and choose Tools > Query Tool.

File » Object « TOOIS |+ Help «
i\ Browser P & |Query Tool
E} E Servers (1)
& E
E}l:J Databases (2)
@[ edb
l_J postgres
% Login/Group Rolez
- 8 Tablespaces & Maintenance

X Restore

& Grant Wizard

16 Enter the following command on the Query-1 tab page to create a database:

create database <database name>;

@ Dashboard ©f Propeties [3 SQL  |» Statistics 4y Dependencies <) Dependents  |¥ Query-1* x
5 B - Q- @ B @ Y .|Noimt -f[sy . @ =z . &

1 |create database db0l; |

17 Click Execute/Refresh, as shown in the following figure.

@ Dashboard ©f Properties [@ SQL | Statistics 4y Dependencies {3 Dependents ¥ Query-1* x

B B. Q. @& B @ v -nom JF].-8 . &

create database db0l;

If the execution is successful, the new database is created.



18 Right-click Databases and choose Refresh from the shortcut menu. Then you can

find the new database.

%} pgAdmin 4 =[5 R]

File +  Object~  Tools ~  Help ~
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o

19 Enter the following command on the Query-1 tab page to create an account:

CREATE ROLE "username" CREATEDB CREATEROLE LOGIN ENCRYPTED PASSWORD
"password';

@ Dashboard § Properties [3 SQL |+ Statistics 4y Dependencies <) Dependents & @

B B . Q. & B @ Y .[(Noimt |5y . m z. &

postgres on doc@Alibaba Cloud RDS

1 [CREATE ROLE "test0l" CREATEDB CREATERCLE LCGIN ENCRYPTED PASSWORD 'L23456']

20Click Execute/Refresh, as shown in the following figure.

@ Dashboard #f Properties [@ SQL | Statistics 4 Dependencies {3 Dependents ¥ Query-1* @

B B . Q. @& B @ v . .Nm -J[5].8 z. <

postgres on doc@Alibaba Cloud RDS

1 CREATE ROLE "test0l" CREATEDS CREATERCLE LOGIN ENCRYPTED PASSWORD '1234536'

If the execution is successful, the new account is created.



21 Right-click Login/Group Roles and choose Refresh from the shortcut menu. Then

you can find the new account.

i\ Browser
- B servers (1)
= =
+ Databases (1)
54 Login/Group Roles (6)

EI‘, aurora
e
M pg4248487

w4 replicator

- Tahlezpaces

FAQ
Can I use the new account of my RDS instance on the corresponding read-only

instances?

The new account will be synchronized to the read-only instances of your RDS
instance. However, you cannot manage the account in the read-only instances. The

new account only has the read permissions on the read-only instances.

APIs
API Description
CreateAccount Used to create an account for an RDS
instance.

3.5 Connect to an RDS for PPAS instance
This topic describes how to connect to an RDS for PPAS instance. After completing
the initial configuration, you can connect to your RDS instance from an ECS

instance or your computer.

You can use a database client or Data Management Service (DMS) to connect to an
RDS instance. This topic describes how to connect to an RDS instance by using DMS

and the pgAdmin 4 client.




Background information

You can log on to DMS from the RDSconsole and then connect to an RDS instance. DMS
offers an integrated solution for data and schema management, access security,

BI charts, data trends, data tracking, performance optimization, and server
management. DMS can be used to manage non-relational databases and relational
databases, such as MySQL, SQL Server, PostgreSQL, MongoDB, and Redis. It can also

be used to manage Linux servers.

You can also use a database client to connect to an RDS instance. ApsaraDB RDS
for PPAS is fully compatible with PPAS. You can connect to RDS in the similar
way you connect to an on-premises PPAS server. This topic describes how to use
the pgAdmin 4 client to connect to an RDS instance. This topic also serves as a
reference if you choose to use other database clients. When you use a client to

connect to an RDS instance, you must set internal and public IP addresses as follows:

- If your client is deployed in an ECS instance and the instance is in the same
region and has the same network type as the target RDS instance, then you can
use the internal IP address. For example, the ECS instance and RDS instance are
both in the VPC located in China (Hangzhou). You can use the internal IP address

provided to create a secure connection.

- Use the public IP address for other situations.
Use DMS to connect to an RDS instance

For more information about how to connect to an RDS instance through DMS, see

Log on to the RDS database through DMS,
Use a client to connect to an RDS instance

1. Add the IP address that is used to access the RDS instance to the RDS whitelist.
For more information about how to configure a whitelist, see Configure a whitelist for

an RDSfor PPASinstance.

2. Start the pgAdmin 4 client.


https://rds.console.aliyun.com/
https://dms-intl.console.aliyun.com/#/dms/login
https://dms-intl.console.aliyun.com/#/dms/login
https://www.alibabacloud.com/help/doc-detail/64703.htm
https://www.alibabacloud.com/help/doc-detail/64703.htm

3. Right-click Servers and choose Create > Server from the shortcut menu.
=)
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PgAdmin is an open source administration and management tool for the PostgreSQL database. The tools include a graphical
administration interface, an SQL query tool, a procedural code debugger and much more. The fool is designed to answer the
needs of developers, DBAS and system administrators alike =
Quick Links
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4. On the General tab of the Create - Server dialog box, enter the name of the server,

as shown in the following figure.

F Create - Server n
General Connection
Name
Server group | B Servers v
Connect now?
Comments

s
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5. Click the Connection tab, and enter the information of the target RDS instance,

as shown in the following figure.

F Create - Server B

General  Connection

Host | |
namefaddress

Maintenance postgres
database

Username | |

Password

Save |:|

password?

Role

SSL mode Prefer j

'Port' must be greater than or equal to 1024.

i ? Save | ¥ Cancel | &® Reset |
Parameter description:

- Host name/address: the endpoint of the RDS instance. If it is an internal

connection, enter the internal endpoint of the RDS instance. If it is an external

Issue: 20191127 -



connection, enter the public endpoint of the RDS instance. To view the

endpoint and the port information of the RDS instance, follow these steps:

a. Log on to the RDSconsole.

b. In the upper-left corner, select the region where the target instance is
located.

c. Find the target instance and click its ID.

d. On the Basic Information page, find the internal and public endpoints and

port numbers of the RDS instance.

Basic Information

I Basic Information Configure Whitelist Migrate Across Zones A

Database Connection s

Monitoring and Alert... China (Hangzhou)ZoneF+ZoneG Primary Instance (High-availability}

P [t endpone] [ s
Serve vl [Putic Endoorc [Focror e

T Local 55D

- Port: the port number of the RDS instance. If it is an internal connection,
enter the port number for internal connections. If it is an external connection,
enter the port number for external connections.

- Username: the name of the premier account for the RDS instance.

- Password: the password of the premier account for the RDS instance.

6. Click Save.
7. If the connection information is correct, choose Servers > Server Name >
Databases > edb or postgres. The following page is displayed, which indicates

that the connection to the RDS instance is successful.

Note:


https://rds.console.aliyun.com/

Edb and postgres are default system databases of the RDS instance. Do not

perform any operation in the two databases.
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pgAdmin 4 - DB:postgres 2017-07-07 11:03:20 CST active no

3.6 Read-only instances

3.6.1 Introduction to PPAS read-only instances
This topic introduces PPAS read-only instances. If your application initiates a small
number of write requests but a large number of read requests, a single instance
may not be able to resist the read pressure. As a result, services may be affected.
To achieve the elastic expansion of the read ability and share the pressure of the
database, you can create one or more read-only instances in a region. The read-
only instances can handle massive read requests and increase the application

throughput.
Overview

A read-only instance is a read-only copy of the master instance. Changes to the
master instance are also automatically synchronized to all relevant read-only

instances.

@ Note:

- RDS for PPAS 10.0 supports read-only instances while PPAS 9.3 does not.



- The configuration of the master instance must be at least 8-core 32 GB (

dedicated or dedicated-host instance).

- Each read-only instance adopts a single-node architecture (without slave nodes).

The following figure shows the topology of read-only instances.
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1
| |
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| T
| |
| |
I
| |
|

! RDS master RDS slave | RDS read-only  RDS read-only RDS read-only
_instance_ _ _______ __[Instance iinstance instance _ ____ instance __ __ |
RDS master instance RDS read-only instance

Pricing

The billing method of read-only instances is Pay-As-You-Go. For more information,

see Pricing.
Features
Read-only instances offer the following features:

- Billing method: Pay-As-You-Go. This method is more flexible and cost-effective.

- Region and zone: Read-only instances are in the same region as the master
instance, but can be in a different zone from the master instance.

- Specifications and storage: Specifications and storage of read-only instances
cannot be lower than those of the master instance.

- Network type: The network type of read-only instances can be different from that of
the master instance.

- Account and database management: Users manage accounts and databases
through the master instance rather than read-only instances.

- Whitelist: When read-only instances are created, they automatically copy
the whitelist of the master instance, but the whitelists of read-only instances
are independent. You can modify the whitelists of the read-only instances by

referring to Configure a whitelist for an RDSfor PPASinstance.


https://www.alibabacloud.com/product/apsaradb-for-rds?spm=a3c0i.7938564.220486.8.10521d15K8Buqg#pricing

- Monitoring and alarms: You can monitor system performance indicators,

including the disk capacity, IOPS, number of connections, and CPU usage.
Limits
- Each master instance can have up to five read-only instances.
- Read-only instances do not support backup settings or manual backups.
- You cannot migrate data to read-only instances.
- You cannot create or delete databases for read-only instances.

- You cannot create or delete accounts for read-only instances.

- You cannot authorize accounts or modify account passwords for read-only

instances.
FAQ

Does an account created in the master instance have permissions on read-only

instances?

The accounts created in the master instance are automatically synchronized to
read-only instances. However, you cannot manage the accounts in the read-only

instances. The accounts only have the read permissions for the read-only instances.

3.6.2 Create a PPAS read-only instance
This topic describes how to create an RDS for PPAS read-only instance. You can
create read-only instances to process massive read requests sent to the database
and increase the application throughput. A read-only instance is a read-only copy
of the master instance. Changes to the master instance are also automatically

synchronized to all relevant read-only instances.
For more information, see Introduction to PPAS read-only instances.
Prerequisites

- The master instance is an RDS for PPAS 10.0 instance.

- The configuration of the master instance must be at least 8-core 32 GB (dedicated

or dedicated-host instance).
Precautions

- You can create read-only instances under a master instance but cannot switch an

existing instance to a read-only instance.



- Creating a read-only instance does not affect the master instance because the
read-only instance copies data from the slave instance.

- Read-only instances do not inherit parameter settings of the master instance, but
use default parameter settings. You can modify the parameter settings on the
console.

- Specifications and storage capacity of each read-only instance cannot be lower
than those of the master instance.

- Each master instance can have up to five read-only instances.

- Aread-only instance is charged according to the Pay-As-You-Go billing method.

That is, fees are deducted for a read-only instance once every hour.
Create a read-only instance

1. Log on to the RDSconsole.

2. Select the target region.
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3. Find the target instance and click its ID.
4. Click Add Read-only Instance.
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https://rds.console.aliyun.com/

5. On the purchase page, select the instance configuration and click Buy Now.

,,,,,

Note:

- We recommend that you deploy read-only instances and the master instance

in the same VPC.

- The configuration (memory and storage) of each read-only instance must be

equal to or higher than that of the master instance.

- You can deploy up to five read-only instances to improve availability and

horizontally scale performance.

6. On the Order Confirmation page, review the order information, select Terms of
Service, Service Level Agreement, and Terms of Use, click Pay Now, and complete

the payment.
The instance creation takes a few minutes.
View a read-only instance
To view a read-only instance in the instance list, follow these steps:

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/

2. Select the target region.
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3. In the instance list, find the read-only instance and click its ID.

Running Jul 18, 2019, 15:06 | Read-only Instance PPAS 10.0

& Running Jul 18, 2019, 14:44  Primary Instance PPAS 10.0

To view a read-only instance on the Basic Information page of the master instance,

follow these steps:

1. Log on to the RDSconsole.

2. Select the target region.
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3. Find the master instance and click its ID.

4. On the Basic Information page of the master instance, move the pointer over the

number below Read-only Instance and click the ID of the read-only instance.
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pe: Local SSD You can reate read-only instances only for dedicated instances that have eight or more CPU


https://rds.console.aliyun.com/

View the delay of a read-only instance

When a read-only instance synchronizes data from the master instance, the read-
only instance may lag behind the master instance by a small amount of time. You

can view the delay on the Basic Information page of the read-only instance.

Local SSD

I Delay for Read-only Instance ~

APls
API Description
#unique 31 Used to create an RDS read-only
instance.

3.7 Read and write external data files by using the oss_fdw
plugin
This topic describes how to read and write external data files by using the oss_fdw
plugin. In Alibaba Cloud, you can use this plugin to load data from 0SS to an RDS
for PostgreSQL or RDS for PPAS instance. You can also write data from an RDS for
PostgreSQL or RDS for PPAS instance to OSS.

oss_fdw parameters

Similar to other fdw interfaces, oss_fdw can encapsulate data stored on 0SS (
external data sources), allowing you to read files on OSS. The process is like reading
data from a table. oss_fdw provides unique parameters used for connecting to and

parsing file data on OSS.

Note:



- Currently, oss_fdw can read and write the following file types in OSS: .text/.csv

files and .text/.csv files in GZIP format.

- The value of each parameter needs to be quoted and cannot contain any useless

spaces.
CREATE SERVER parameters

- ossendpoint: Address (host) used to access 0SS from a private network
+ id: OSS account ID
- key: OSS account key

- bucket: OSS bucket, assigned after an 0SS account is created

The following parameters are related to error tolerance in import and export
modes. If network connectivity is poor, you can reconfigure these parameters to

facilitate successful imports and exports.

- oss_connect_timeout: Connection expiration time, measured in seconds. Default
value: 10s.

- oss_dns_cache_timeout: DNS expiration time, measured in seconds. Default
value: 60s.

- oss_speed_limit: Minimum tolerable rate. Default value: 1,024 byte/s (1 Kbit/s).

- oss_speed_time: Maximum tolerable time. Default value: 15s.

If the default values of the oss_speed_1limit and oss_speed_time parameters are
used, a timeout error occurs when the transmission rate is smaller than 1 Kbit/s for

15 consecutive seconds.
CREATE FOREIGN TABLE parameters
+ filepath: File name including a path on OSS.

- A file name contains a path but not a bucket name.

- This parameter matches multiple files in the corresponding path on 0SS, and

supports file loading to a database.
- Files named in the format of filepath or filepath.x can be imported to a

database. x in filepath.x must start from 1 and be consecutive.

For example, if there are five files, filepath, filepath. 1, filepath. 2,
filepath. 3, and filepath. 5, then the first four files are matched and

imported, but the file named filepath. 5 is not.



- dir: Virtual directory on OSS.

- The value of this parameter must end with a slash (/).

- All files (excluding subfolders and files in subfolders) in the virtual directory

indicated by this parameter are matched and imported to a database.

- prefix: Prefix of the path in the data file. Regular expressions are not supported.
You can set only one of the these parameters: prefix, filepath, and dir.

- format: File format, which can only be CSV currently.

- encoding: File data encoding format. It supports common PostgreSQL encoding
formats, such as UTF-8.

+ parse_errors: Parsing in error tolerance mode. The errors that occur during the
file parsing process are ignored by row.

- delimiter: Delimiter specified for columns.

- quote: Quote character for a specified file.

- escape: Escape character for a specified file.

- null: Used to nullify the column matching a specified string. For example, null
"test' is used to set the column whose value is test to null.

- force_not_null: Used to un-nullify the value of one or more columns. For
example, force_not_null 'id' isused to set the values of the id column to
empty strings.

- compressiontype: Used to set whether the file read or written on 0SS is

compressed and set the compression format. Values:

- none: Uncompressed (default value)
- gzip: compressed gzip file
- compressionlevel: Used to set the compression level of the compression format

written to 0SS. Value range: 1 to 9. Default value: 6.

Note:

- The filepath and dir parameters need to be specified in the OPTIONS parameter.
- Either the filepath or dir parameter must be specified, and they cannot be
specified at the same time.

- The export mode currently only supports virtual folders, that is, only the dir

parameter is supported.



Export mode parameters for CREATE FOREIGN TABLE

- oss_flush_block_size: Buffer size for the data written to OSS at a time. Its
default value is 32 MB, and the value range is 1 MB to 128 MB.

- oss_file_max_size: Maximum file size for the data written to OSS (subsequent
data is written in another file when the maximum file size is exceeded). Its
default value is 1,024 MB, and the value range is 8 MB to 4,000 MB.

-+ num_parallel_worker: The number of parallel compression threads in the

compression mode in which the OSS data is written, ranging from 1 to 8. Its

default value is 3.
Auxiliary function
FUNCTION oss_fdw_list_file (relname text, schema text DEFAULT 'public')

- Used to obtain the name and size of the 0SS file that an external table matches.

- The unit of file size is byte.

select * from oss_fdw_T1list_file('t_oss');
name | size

oss_test/test.gz. 1 | 739698350
oss_test/test.gz. 2 | 739413041
oss_test/test.gz. 3 | 739562048
(3 rows)

Auxiliary feature

oss_fdw.rds_read_one_file: In read mode, it is used to specify a file that matches
the external table. Once it is set, the external table matches only one file that is set

during data import.
For example, set oss_fdw.rds_read_one_file = ‘oss_test/examplel6.csv. 1’ ;

set oss_fdw.rds_read_one_file = 'oss_test/test.gz. 2';
select * from oss_fdw_T1list_file('t_oss');
name | size

oss_test/test.gz. 2 | 739413041
(1 rows)

oss_fdw example

# (PostgreSQL) Create the plugin

create extension oss_fdw; ----For PPAS, run: select rds_manage

_extension('create','oss_fdw');

# Create a server qinstance

CREATE SERVER ossserver FOREIGN DATA WRAPPER oss_fdw OPTIONS
(host 'oss-cn-hangzhou.aliyuncs.com' id 'xxx', key 'xxx',

bucket 'mybucket');

b



# Create an 0SS external table
CREATE FOREIGN TABLE ossexample
(date text, time text, open float,
high float, low float, volume 1int)
SERVER ossserver
OPTIONS ( filepath 'osstest/example.csv', delimiter ' '
format 'esv', encoding 'utf8', PARSE_ERRORS 'lOO?);
# Create a table, to which data is loaded
create table example
(date text, time text, open float,
high float, Tlow float, volume 1int);
# Load data from ossexample to example.
insert into example select * from ossexample;
# As you can see
# oss_fdw estimates the file size on 0SS and formulates a query plan
correctly.
explain insert into example select * from ossexample;
QUERY PLAN

Insert on example (cost=0.00.. 1.60 rows=6 width=92)
-> Foreign Scan on ossexample (cost=0.00.. 1.60 rows=6 width=92)

Foreign OssFile: osstest/example.csv. 0
Foreign OssFile Size: 728

(4 rows)

# Write the data in the example table to 0SS.

insert into ossexample select * from example;

explain insert into ossexample select * from example;

QUERY PLAN

Insert on ossexample (cost=0.00..16.60 rows=660 width=92)

-> Seq Scan on example (cost=0.00..16.60 rows=660 width=92)
(2 rows)

oss_fdw usage tips

- oss_fdw is an external table plugin developed based on the PostgreSQL FOREIGN
TABLE framework.
- The data import performance is related to the PostgreSQL cluster resources (CPU

I/O MEM MET) and OSS.

- For expected data import performance, ossendpoint in ossprotocol must match
the region where PostgreSQL is located in Alibaba Cloud. For more information,

see Endpoints.

- If the error "oss endpoint userendpoint not in aliyun white list" is triggered
during reading of SQL statements for external tables, use these regions and endpoints.

If the problem persists, submit a trouble ticket.
Error handling

When an import or export error occurs, the error log contains the following

information:

- code: HTTP status code of the erroneous request.


https://www.alibabacloud.com/help/doc-detail/31834.htm
https://www.alibabacloud.com/help/doc-detail/31837.htm

- error_code: Error code returned by OSS.
- error_msg: Error message provided by OSS.
- req_id: UUID that identifies the request. If you cannot solve the problem, you

can seek help from OSS development engineers by providing the req_id.
Timeout errors can be handled by using oss_ext parameters.
For more information about error types, see the following resources:

+ OSShelp
+ PostgreSQL CREATE FOREIGN TABLE
* Exception handling

+ OSSerror response
Hide IDs and keys

If the id and key parameters for CREATE SERVER are not encrypted, plaintext
information is displayed by using select x from pg_foreign_server, making

the ID and key exposed. The symmetric encryption can be performed to hide the
ID and key (use different keys of different instances for further protection of your
information). However, to avoid incompatibility with old instances, you cannot use

methods similar to GP to add a data type.
Encrypted information:

postgres=# select * from pg_foreign_server ;

srvname | srvowner | srvfdw | srvtype | srvversion | srvacl |

srvoptions
——————————— e ittt T R et B
. SRR
‘ossserver | 10 | 16390 | | | | fhost

=oss-cn-hangzhou-zmf.aliyuncs.com, id=MD5xxxxxxxx, key=MD5XXXXXXXX,
bucket=067862}

The encrypted information is preceded by MD5 (total length: len%8==3). Therefore
, encryption is not performed again when the exported data is imported. But you

cannot create the key and ID preceded by MD5.


https://www.alibabacloud.com/help/product/31815.htm
http://www.postgresql.org/docs/9.4/static/sql-createforeigntable.html
https://www.alibabacloud.com/help/doc-detail/32141.htm
https://www.alibabacloud.com/help/doc-detail/32005.htm

4 Data migration

4.1 Migrate data between ApsaraDB for RDS instances

You can seamlessly migrate data between ApsaraDB for RDS instances.

For more information, see Migrate data between ApsaraDB for RDSinstances.

4.2 Migrate data from an ApsaraDB RDS for PPAS instance to an
on-premises Oracle database

This topic describes how to migrate data from an ApsaraDB RDS for PPAS instance
to an on-premises Oracle database.

Limits
Currently, only files of common data types can be exported. Binary data types such
as BLOB are not supported.

Prerequisites

- A server that has an Oracle database installed is available.

- The IP address of the Oracle database server is added to the whitelist of the
ApsaraDB RDS for PPAS instance. For more information, see Configure a whitelist for

an RDSfor PPASIinstance.

- A table that has the same schema as ApsaraDB RDS for PPAS database tables is

created in the Oracle database.

- The PostgreSQL client is uploaded to the Oracle database server.

Procedure

Note:
The following example demonstrates how to migrate data from an ApsaraDB
RDS for PPAS instance to an Oracle database installed in an ECS instance. In this

example, the operating system of the ECS instance is CentOS 6.5.
1. Install the PostgreSQL client on the Oracle database server.

[root@oraclexe ~]# yum install postgresql.x86_64
[root@oraclexe ~]# /usr/bin/psql --version


https://www.alibabacloud.com/help/zh/doc-detail/26626.htm

psql (PostgreSQL) 8.4.20

2. Configure password-free logon for the ApsaraDB RDS for PPAS instance in the
ECS instance.
[root@oraclexe ~]# vim ~/.pgpass
[root@oraclexe ~]# cat ~/.pgpass
rm-2ze46615ulk657yyn.ppas.rds.aliyuncs.com:3433:0ra:myadmin: XxXXXXXX
//The parameter must be in the HOSTNAME:PORT:DATABASE :USERNAME:

PASSWORD format.
[root@oraclexe ~]# chmod 0600 ~/.pgpass

Note:
The .pgpass configuration file is located in the HOME directory.
3. Test the connectivity between the ECS instance and the ApsaraDB RDS for PPAS

instance.

[root@oraclexe ~]# psql -h rm-2ze46615ulk657yyn.ppas.rds.aliyuncs.
com —-p 3433 -U myadmin ora

psql.bin (9.3.1.3, server 9.3.13.37)

Enter "help" to obtain help information.

ora=>

If you can log on to the ApsaraDB RDS for PPAS instance as the ora user, the
connection has been established. After the test is complete, switch back to the
root user.

ora=> \q
[root@oraclexe ~]#

4. Create a data export script in the ECS instance.
a. Create the ppas_exp_all_tables_to_csv.sh file.

vi ppas_exp_all_tables_to_csv.sh

b. Insert the following text into the ppas_exp_all_tables_to_csv.sh script:

# ppas_exp_all_tables_to_csv.sh <hostname> <port> <username> <
database>

# Author: Xiao Shaocong (Scott Siu)

# E-Mail: shaocong.xsc@alibaba-inc.com
TMP_PATH="/tmp/ppas_tables_$1_$2_$3_s%4"

mkdir S$STMP_PATH

if [ $? -ne 0 ]

then
exit 1;
fi
echo "select '$1 $2 $3 $4 ' || tablename || ' $TMP_PATH ' ||

tablename from pg_tables where tableowner='$3' and (schemaname='$3
' or schemaname='public');" > /tmp/ppas_tables_$1_%$2_$3_%4.sql
psql -h $1 -p $2 -U $3 $4 -f /tmp/ppas_tables_$1_%$2_$3_%4.sql |
head -n -2 | tail -n +3 | awk -F " " '"{printf ("psql -h %s -p %s -



U %s %s -c \"\\copy %s TO '\''%s/%s'\'' CSV HEADER\"\n",$1,%$2,$3,$
4,$5,$6,57)}' | sh

5. Grant execution permission to the ppas_exp_all_tables_to_csv.sh script.

[root@oraclexe ~]# chmod 0755 ppas_exp_all_tables_to_csv.sh

6. Execute the data export script in the ECS instance.

[root@oraclexe ~]# ./ppas_exp_all_tables_to_csv.sh rm-2ze46615ul
k657yyn.ppas.rds.aliyuncs.com 3433 myadmin ora

7. Verify the data exported to a CSV file.

[root@oraclexe ~]# cat /tmp/ppas_tables_rm-2ze46615ulk657yyn.ppas.
rds.aliyuncs.com_3433_myadmin_ora/*

deptno,dname, loc

10,ACCOUNTING,NEW YORK

20,RESEARCH,DALLAS

30,SALES,CHICAGO

40 ,0PERATIONS,BOSTON
empno,ename,job,mgr,hiredate,sal,comm,deptno
7369,SMITH,CLERK,7902,17-DEC-80 00:00:00,800.00,,20

7499 ,ALLEN,SALESMAN, 7698,20-FEB-81 00:00:00,1600.00,300.00,30
7521,WARD, SALESMAN, 7698 ,22-FEB-81 00:00:00,1250.00,500.00,30
7566, JONES ,MANAGER,7839,02-APR-81 00:00:00,2975.00,,20

7654 ,MARTIN,SALESMAN,7698,28-SEP-81 00:00:00,1250.00,1400.00,30
7698 ,BLAKE ,MANAGER,7839,01-MAY-81 00:00:00,2850.00, ,30

7782 ,CLARK,MANAGER,7839,09-JUN-81 00:00:00,2450.00,,10
7788,SCOTT,ANALYST,7566,19-APR-87 00:00:00,3000.00,,20
7839,KING,PRESIDENT, ,17-NOV-81 00:00:00,5000.00,,10

7844, TURNER, SALESMAN, 7698 ,08-SEP-81 00:00:00,1500.00,0.00,30
7876 ,ADAMS ,CLERK,7788,23-MAY-87 00:00:00,1100.00,,20

7900 ,JAMES,CLERK,7698,03-DEC-81 00:00:00,950.00, ,30

7902 ,FORD,ANALYST,7566,03-DEC-81 00:00:00,3000.00,,20

7934, ,MILLER,CLERK,7782,23-JAN-82 00:00:00,1300.00,,10
empno,startdate,enddate,job,sal,comm,deptno,chgdesc
7369,17-DEC-80 00:00:00,,CLERK,800.00,,20,New Hire
7499,20-FEB-81 00:00:00, ,SALESMAN,1600.00,300.00,30,New Hire
7521,22-FEB-81 00:00:00,,SALESMAN,1250.00,500.00,30,New Hire
7566,02-APR-81 00:00:00, ,MANAGER,2975.00,,20,New Hire
7654,28-SEP-81 00:00:00, ,SALESMAN,1250.00,1400.00,30,New Hire
7698,01-MAY-81 00:00:00, ,MANAGER,2850.00,,30,New Hire
7782,09-JUN-81 00:00:00, ,MANAGER,2450.00,,10,New Hire
7788,19-APR-87 00:00:00,12-APR-88 00:00:00,CLERK,1000.00,,20,New
Hire

7788,13-APR-88 00:00:00,04-MAY-89 00:00:00,CLERK,1040.00,,20,Raise
7788,05-MAY-90 00:00:00, ,ANALYST,3000.00,,20,Promoted to Analyst
7839,17-NOV-81 00:00:00, ,PRESIDENT,5000.00,,10,New Hire

7844 ,08-SEP-81 00:00:00, ,SALESMAN,1500.00,0.00,30,New Hire
7876,23-MAY-87 00:00:00,,CLERK,1100.00,,20,New Hire
7900,03-DEC-81 00:00:00,14-JAN-83 00:00:00,CLERK,950.00,,10,New
Hire

7900,15-JAN-83 00:00:00, ,CLERK,950.00,,30,Changed to Dept 30
7902,03-DEC-81 00:00:00, ,ANALYST,3000.00,,20,New Hire



7934,23-JAN-82 00:00:00,,CLERK,1300.00,,10,New Hire
8. Import the CSV file to the Oracle database.

- Solution 1: Use the Oracle SQL*Loader utility to import data. For more
information, see Oracle SQL Loader Overview.
- Solution 2: Use Oracle SQL Developer to import data. For more information,

see SQL Developer Concepts and Usage.

Troubleshooting

Error
When you execute the data export script, the system prompts that a directory

cannot be created, as shown below.

[root@oraclexe ~]# ./ppas_exp_all_tables_to_csv.sh rm-2ze46615ul
k657yyn.ppas.rds.aliyuncs.com 3433 myadmin ora

mkdir: Unable to create directory"/tmp/ppas_tables_rm-2ze46615ul
k657yyn.ppas.rds.aliyuncs.com_3433_myadmin_ora": The file already

exists.

Troubleshooting procedure
Delete the existing directory.

[root@oraclexe ~]# rm -rf /tmp/ppas_tables_rm-2ze46615ulk657yyn.ppas.
rds.aliyuncs.com_3433_myadmin_ora

4.3 Migrate data from an ApsaraDB RDS for PPAS instance to an
on-premises PPAS database
You can use logical backup files to migrate data from an ApsaraDB RDS for PPAS
instance to an on-premises PPAS database.

Procedure

1. Connect the PostgreSQL client to ApsaraDB RDS for PPAS.


http://www.oracle.com/technetwork/database/enterprise-edition/sql-loader-overview-095816.html
https://docs.oracle.com/cd/E35137_01/appdev.32/e35117/intro.htm

2. Run the following command to back up data:

pg_dump -U username -h hostname -p port databasename -f filename

The parameters are described as follows:

- username: the username that is used to log on to the ApsaraDB RDS for PPAS

database.
- hostname: the hostname of the ApsaraDB RDS for PPAS database.
- port: the port number of the ApsaraDB RDS for PPAS database.
- databasename: the name of the ApsaraDB RDS for PPAS database that you

want to back up.

- filename: the name of the backup file to be generated. Example:

pg_dump -U ppas_user -h rdsv07z563m7025cj550public.ppas.rds.
aliyuncs.com -p 3433 edb -f ppas.sql

3. Save the ppas. sql backup file to the destination server.

4. Run the following command to restore data to the on-premises database:

psql -U username -h hostname -d desintationdb -p port -f dumpfilena
me.sql

The parameters are described as follows:

- username: the username that is used to log on to the on-premises database.
- hostname: the hostname of the on-premises database.

- port: the port number of the on-premises database.

- databasename: the name of the on-premises database.

- filename: the name of the backup file. Example:

psql -U ppas_user -h localhost -d edb -p 5444 -f ppas.sql

Permission settings of the ApsaraDB RDS for PPAS database are different
from those of the on-premises database. Therefore, some permission-related
warnings or errors may occur during data import. Examples of warnings or

errors that can be ignored are as follows:

WARNING: no privileges could be revoked for "xxxxx"
ERROR: role "xxxxx" does not exist



5 Billing

5.1 Switch from pay-as-you-go billing to subscription billing
This topic describes how to change the billing method of an RDS for PPAS instance

from pay-as-you-go to (monthly or annual) subscription.
Impacts

Changing the billing method does not interrupt the running of your RDS instance.
Precautions

- You cannot change the billing method of an RDS instance from subscription to
pay-as-you-go. To optimize your cost plan, you must evaluate your usage model
thoroughly before you change the billing method of your RDS instance.

- If an RDS instance has an unpaid subscription order, the subscription order
becomes invalid after you upgrade the instance type. In such case, you must first
go to the Orders page in the RDS console to cancel the subscription order, and then

change the billing method to subscription again.
Prerequisites

- The instance type cannot be a historical one, which means that the instance
type must be available for sale. For more information about historical instance
types, see #unique_19. Before you change the billing method of a historical-type
RDS instance to subscription, you must change the instance type to one that is
available for sale. For detailed steps, see Change the configuration of an RDSfor PPAS
instance.

- The RDS instance uses the pay-as-you-go billing method.

- The RDS instance is in the Running state.

- The RDS instance does not have an unpaid subscription order.
Procedure

1. Log on to the RDSconsole.


https://expense.console.aliyun.com/#/order/list/
https://rds.console.aliyun.com

2. Select the target region.

: (-] Alibaba Cloud

RDS instz
ApsaraDB for RDS

RDS Mai
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apan (Tokyo,

3. Find the target RDS instance and use one of the following two methods to open

the Switch to Subscription Billing page.

- In the Actions column, click Subscription Billing.
- Click the instance ID. Then in the Status section of the Basic Information page,

click Subscription Billing.

I Status
4. Select a duration of purchase.
5. Read and confirm you agree to Terms of Service, Service Level Agreement, and
Terms of Use by selecting the heckBcbx, confirm the order details, and click Pay

Now.

Note:
The system generates a subscription order. If this order is not paid or canceled,
you cannot change the billing method of this RDS instance from pay-as-you-go
to subscription or purchase a new RDS instance. You can go to the Orders page to
pay for or cancel this order.

6. Complete the payment.

5.2 Manually renew an RDS for PPAS instance
This topic describes how to manually renew an RDS for PPAS instance that is
charged by using subscription billing. If a subscription RDS instance expires and

is not renewed in time, services will be stopped and data may be permanently
deleted.

For more information about the impacts, see Expiration and overdue policy.


https://expense.console.aliyun.com/#/order/list/

g] Note:

A pay-as-you-go-based instance does not have an expiration date and no renewal is

required.

You can manually renew a subscription-based instance before it expires or within

15 days after it expires.
Method 1: Renew an RDS instance in the RDS console

1. Log on to the RDSconsole.

2. Select the target region.

(-] Alibaba Cloud | China (Hangzhou)
Mys Asia Padific Europe & Americas
raDB for RDS @B china (Hangzhou) W Germany (Frankfurt)

K]
A

rDs B China (Shanghai) = UK (London)

ances

Bl china (Qingdan) B= us (Silicon Valley)
ss-region Backup Bas. @ china (Beijing) &= Us (virginia)
lrad Tnetanecae f00 “ China [Zhaﬂgjiak{lu]

3. Find the target RDS instance and in the Actions column click Renew.
4. On the Renew Subscription page, select a duration. The longer the duration, the

bigger discount you have.

Renew Subscription

Refund instruction

Change Configuration

5. Read and confirm you agree to Terms of Service, Service Level Agreement, and
Terms of Useby selecting the checkbox, confirm the order details, and click Pay

Now.
Renew an RDS instance in the Renew console

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/
https://rds.console.aliyun.com/

2. In the upper-right corner of the page, choose Billing Management > Renew.
Q More [ fa} &5 English

instances with Standard and Enhanced cloud SSD support SQL explorer now. It is 0 discount to Septen Orders Ignore

Billing Management

Learnj [ol:} = Refresh

3. In the left-side navigation pane, click ApsaraDB for RDS.
4. On the Manually Renew tab, find the target RDS instance and in the Actions

column click Renew

-

Note:

- If the target RDS instance is on the Don't Renew tab, you can click Enable
Manual Renew in the Actions column to restore the instance to manual
renewal.

- If the target RDS instance is on the Auto-Renew tab, you can click Modify
Auto-Renew in the Actions column, and then in the displayed dialog box

select Disable Auto-Renew and click OK to restore the instance to manual

renewal.
Auto-Renew Don't Renew
Instances to Manually Renew: 2
Instance Name Status Regional Node Database type Expiration Date Remaining Days Actions
Normal EU Cz.amtral 1(Fra MysaL Sep 5, 2019, 00:0 9 Days :
nkfurt) 1]
Normal ;hlna CRnoon MariaDB I-Uﬂar 2 2T (LD 188 Days

5. Select a duration, read and confirm you agree to Terms of Service, Service Level
Agreement, and Terms of Use by selecting the checkbox, confirm the order

details, and click Pay Now.
Auto-renewal

Enabling auto-renewal guarantees that your business runs smoothly without the
need of manual renewal when your instance expires. For more information, see

Automatically renew an RDSfor PPASinstance.



5.3 Automatically renew an RDS for PPAS instance

This topic describes how to automatically renew an RDS for PPAS instance. Each
subscription-based instance has an expiration date. If an instance is not renewed in
time when the instance expires, a service interruption or even data loss may occur.
Enabling auto-renewal guarantees that your business runs smoothly without the

need of manual renewal when your instance expires.

For more information about the impacts, see Expiration and overdue policy.

Note:
A pay-as-you-go-based instance does not have an expiration date and no renewal is

required.
Precautions

- If you have enabled automatic renewal for your subscription-based instance, a
payment will be deducted three days before the expiration date. You can pay the
fees by credit cards or coupons. Make sure that your credit card has sufficient
balance.

- If you manually renew an instance before the automatic deduction date, the
system will automatically renew the instance before the next expiration date.

- The automatic renewal function takes effect the next day after you enable it.
If your instance expires the next day, renew it manually to prevent service

interruption. For more information, see Manually renew an RDSfor PPASinstance.

Enable automatic renewal when you purchase an RDS instance

Note:
After you enable automatic renewal, the system automatically renews your
instance based on the specified Duration when the instance expires. For example,
if you have purchased a three-month subscription-based instance and selected
Auto-renewal, the fees are automatically paid every three months for each

renewal.

When you purchase a subscription-based instance, you can select Auto Renewal on the

purchase page.


https://rds-buy.aliyun.com/#/create/rds

The longer subscription, the more discount.

Duration : 1 2 3 4 5 6 7 8 9 v || (i G EC

There is an early-cancellation fee for withdraws from annual subscriptions. Learn moreRefund instruction

Quantity 1

Enable automatic renewal after you purchase an RDS instance

@ Note:

After you enable automatic renewal, the system automatically renews your
instance based on the selected renewal duration. For example, if you select a three-

month renewal duration, the fees are automatically paid every three months for

each renewal.

1. Log on to the RDSconsole.

2. In the upper-right corner, choose Billing Management > Renew.

[o} Billing Management  More [ fa} o English

instances with Standard and Enhanced cloud SSD support SQL explorer now. It is 0 discount to Septen Orders Ignore

Billing Management

Learnj [ol:} < Refresh Create Instance

3. In the left-side navigation pane, click ApsaraDB for RDS.

CA'Y



https://rds.console.aliyun.com/

4. On the Manually Renew or Auto-Renew tab, find the target RDS instance. You can

enable automatic renewal for one or more RDS instances at a time.
- Follow these steps to enable automatic renewal for one RDS instance:

a. Find the target RDS instance and in the Actions column click Enable Auto-

Renew.
Manually Rene Auto-Renew Don't Renew
Instances to Manually Renew: 3
Instance Name Status Regional Node Database type Expiration Date Remaining Days Actions

EU Central 1 (F Sep 5, 2019, 00:0 Rene
Normal snral T pysaL o0 9 Days
nkfurt) 0

b. In the displayed dialog box, set Auto-Renew Cycle and click Enable Auto-

Renew.

- Follow these steps to enable auto-renewal for more than one RDS instance:

Select the target RDS instances, and click Enable Auto-Renew below the
instance list.
- In the displayed dialog box, set Auto-Renew Cycle and click Enable Auto-

Renew.
Change the auto-renew cycle of an RDS instance

1. Log on to the RDSconsole.

2. In the upper-right corner, choose Billing Management > Renew.

Q  Billing Management More [ 4 £  English

instances with Standard and Enhanced cloud SSD support SQL explorer now. It is 0 discount to Septen Orders Ignore

Billing Management

Learnj [ol:} = Refresh Create Instance

3. In the left-side navigation pane, click ApsaraDB for RDS.
4. On the Auto-Renew tab, find the target RDS instance and in the Actions column

click Modify Auto-Renew.

lanually Rene Auto-Rene Don't Renew
Instances to Auto-Renew: 5
Instance Regional Expiration Remaining
Status Database type Renewal cycle Actions
Name Node Date Days
Rene
Normal EU Ceniral 1 MySQL Sep8.2018.0 gpoe 1 Month

(Frankfurt) 0:00
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5. In the displayed dialog box, select Modify Auto-Renew Cycle, select an auto-

renew cycle, and click OK.
Disable automatic renewal for an RDS instance

1. Log on to the RDSconsole.

2. In the upper-right corner, choose Billing Management > Renew.
Q Billing Management More oy English

instances with Standard and Enhanced cloud S50 support SQL explorer now. It is 0 discount to Septen Orders Ignore

Billing Management

Lean DB < Refresh Create Instance

3. In the left-side navigation pane, click ApsaraDB for RDS.
4. On the Auto-Renew tab, find the target RDS instance and in the Actions column
click Modify Auto-Renew.

Auto-Renew Don't Renew
Instances to Auto-Renew: 5
Instance Regional Expiration Remaining
Status Database type Renewal cycle Actions
Name Node Date Days
) EU Central 1 Sep5, 2019, 0 ) -
Mormal (Frankiur) MySQL 0:00 9 Days 1 Month

5. In the displayed dialog box, select Disable Auto-Renew and click OK.

APIls

Operation Description

#unique_20 Used to create an RDS instance.
ol

[:] Note:

Automatic renewal is enabled when

you create the instance.

#unique_43 Used to renew a subscription-based RDS
instance.
ol
[:] Note:
Automatic renewal is enabled after you
create the instance.
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6 Instance

6.1 Restart an RDS for PPAS instance

This topic describes how to restart an RDS for PPAS instance in the RDS console if
the number of connections exceeds its upper limit or any performance issue occurs

for the instance.
Impact

Restarting an RDS instance may interrupt its connections and impact your services

. Exercise caution when performing this action.
Procedure

1. Log on to the RDSconsole.

2. Select the target region.

= (-] Alibaba Cloud a n L n
RDS inste 53 t2 by OpendPI for long- s Ignore
ApsaraDB for RDS
RDS Mal Learning Path Leg On to DB < Refresh _ammm
nstaness
Cross-region Backup gasicinl gl @

Locked Instances (0) e
Instance

china
201, . PCIVDC P2
Hangzhou 2 0 o
ON : Yo
ZoneH
by a vPC
hina
VPC P
Hangzho o Man Subseription Billing
ZoneH )

c1FEIBEEEE

3. Find the target RDS instance. Then, click the instance ID or in the Actions
column click Manage.

4. In the upper-right corner of the Basic Information page, clickRestart Instance.

Operation Guide Log On to DB Create Datz Migration Task Back Up Instance C Refresh =

Configure Whitelist Migrate Across Zones ~ Distributed by Instance Role ~

pgm- rd
Read-only Instance

0

Add Read-only Instance

Primary Instance (High-availability)

3433

‘You can create read-only instances only for dedicated instances that have eight or more CPU
cores,
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5. In the displayed dialog box, click Confirm.

APIls

API Description

#unique 46 Used to restart an RDS instance.

6.2 Set the maintenance window of an RDS for PPAS instance

This topic describes how to set the maintenance window of an RDS for PPAS
instance so that RDS for PPAS can perform regular maintenance operations as
needed according to a defined schedule. The default maintenance window is from
02:00 to 06:00. You can set the maintenance window to the off-peak period of your

business to avoid impacts on business.
Precautions

- Before maintenance is performed, ApsaraDB for RDS sends SMS messages and
emails to the contacts listed in your Alibaba Cloud accounts.

- To guarantee service stability during the maintenance process, the instance
enters the Instance Maintaining state before the maintenance time on the
day of maintenance. When the instance is in this state, access to data in the
database and query operations such as performance monitoring are not affected.
However, apart from account and database management and IP address whitelist
configuration, modification operations such as upgrade, downgrade, and restart
are temporarily unavailable.

- During the maintenance window, the instance is disconnected once or twice.
Make sure that you configure automatic reconnection policies for your applicatio

ns to avoid service disruptions.
Procedure

1. Log on to the RDS consoleRDS console.


https://rds.console.aliyun.com/
https://partners-intl.aliyun.com/login-required#/rds

2. Select the target region.

= (-] Alibaba Cloud

Rosinstz
ApsaraDB for RDS

e 1B IiEEEEEEEEE

3. Find the target RDS instance. Then, click the instance ID, or in the Actions
column click Manage.
4. On the Basic Information page, find the Configuration Information section and

click Configure to the right of Maintenance Window.

Configuration Information
General-purpose

204EMB

02:00-06:00 Configure

5. Select a maintenance window and click Save.

-
[:] Note:

The maintenance window is in China Standard Time (UTC +8).

APIs
API Description
#unique_48 Used to change the maintenance
window of an RDS instance.

6.3 Migrate an RDS for PPAS instance across zones in the same
region
This topic describes how to migrate an RDS for PPAS instance across zones in

the same region. The attributes, configuration, and connection addresses of



the instance remain unchanged after the migration. The time required for the

migration varies depending on the data volume of the instance. In typical cases, the

migration takes a few hours.

Migration scenarios

Migration scenario

Description

Migrate an RDS
instance from one
zone to another

The zone where the RDS instance is located is overloaded or
cannot meet the performance requirements of the instance.

Migrate an RDS
instance from one
zone to multiple
zones

The master and slave nodes are located in different
equipment rooms in different zones to enhance disaster
tolerance.

A multi-zone instance is superior to a single-zone instance
because it can survive more disasters. For example, a single-
zone instance can survive server and rack faults while a multi

-zone instance can survive equipment room faults.

Migrate an RDS
instance from
multiple zones to
one zone

This scenario is provided to meet the requirements of
specific functions.

This function is free of charge. No fee is charged even when you migrate an RDS

instance from one zone to multiple zones.

Prerequisites

This function is available only when the region to which your RDS instance belongs

has more than one zone.

Precautions

During the migration, the connection to your RDS instance remains unavailable

for 30 seconds, and most operations related to databases, accounts, and networks

cannot be performed. Make sure that your application can be automatically

reconnected to your RDS instance after the migration. Additionally, perform the

migration during off-peak hours.




Procedure

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.
= (_) Alibaba Cloud ch Q  Billing Management M B A @ Enih @
RDS instz stics. You can save data by OpenAPI for long-term queries. Ignore
ApsaraDB for RDS Bl china (Hangzhou)
RDS Mai @l China (Shanghai) Learning Path Log On to DB Z Refresh Create Instance
nstances @ e @
Cross region Backup gasicini @l China (B
—— Bl china (7
Locked Instances (0) R o=
Bl china (Hon
@ cnin
B cnin
Bl Hong K « Ve
2017 e {VRCvoc Pay-hs-
- b (Hangzhou) & oo 0 Manage | M
i ZoneH “
& australia
& & vee
o China { VPC:vpe Pay-As
- (Hangzhou) ‘ ) Fay-hs- 0 Man: Subscription Billing | Mor
Sia You-Go
ZoneH
. an (Tok

3. Find the target RDS instance and click its ID.
4. In the Basic Information section of the Basic Information page, click Migrate

Across Zones.

Basic Information Configure 'Whits

China (Hangzhou)ZoneH+Zonel )
availabil

Configure Whitelist to view the internal IP address.
Apply for Public Endpoint
Local 550

Mote: Use the preceding connection string to connect to the instance. You need to change the VIP in the connection strir

5. In the displayed dialog box, specify the destination zone, VSwitch, and migration

time, and click OK.

[% Note:

If you want to change the maintenance window, follow these steps:
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a. Click Change.

b. In the Configuration Information section, specify the maintenance window

Switch Immediately After Data Migration [®!Switch Within Maintenance Window ( Current Setting: 02:00-06:00)[Modify]

and click Save.

06:00-07:00 07:00-08:00 05:00-09:00 09:00-10:00

10:00-11:00 11:00-12:00 12:00-13:00 13:00-14:00

14:00-15:00 15:00-16:00 16:00-17:00 17:00-18:00

15:00-19:00 19:00-20:00 20:00-21:00 21:00-22:00

22:00-23:00 23:00-00:00 00:00-01:00 01:00-02:00

02:00-032:00 03:00-04:00 04:00-05:00 05:00-06:00
Cancel

c. Refresh the page, and perform the migration again.

APls
API Description
#unique_50 Used to migrate an RDS instance across
zones.

6.4 Switch over services between the RDS for PPAS master and
slave instances

This topic describes how to switch over services between the RDS for PPAS master

and slave instances.

A High-availability Edition instance has a slave instance, and the data is synchroniz
ed between both instances in real time. You can only access the master instance

. The slave instance is a backup instance and cannot be accessed. You can switch
your services from the master instance to the slave instance. After the switchover,

the original master instance becomes the slave instance.

If the master instance cannot be accessed, your business is automatically switched

to the slave instance.



Precautions

During the switchover, your RDS instance may be disconnected. Make sure that
your application can automatically reconnect to your RDS instance after the

switchover.
Procedure

1. Log on to the ApsaraDB for RDSconsole.

2. In the upper-left corner of the page, select the region where the instance is

located.
H =D Alibaba Cloud Q onganacener B o oa e @
rDS Mar @l Chinz IS‘ar\;"\a-“ Le Log On to DB T Refresh
reanees @8 iz @
Cross-region Backup Basic Inf & chi
Locked Instances (0) e °
o B :
@ cni
B cni
@m . China e Payots
) - i ZoneH ouco
3. Find the instance and click the instance ID.
4. In the left-side navigation pane, click Service Availability.
5. Inthe Availability Information section, click Switch Primary/Secondary
Instance.
Awailability Information Configure Primary/Secondary Switchover

Single-zone
Semi-synchronous

ZoneF)

witch Pril

100.0%
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6. Select an appropriate time to perform the switch, and click OK.

During the switch, operations such as managing the databases and accounts and
switchover the network types cannot be performed. Therefore, we recommend

that you select Switch Within Maintenance Window.

Master/Slave Node Switchover

Are you sure you want to proceed with master/slave node switch? You may experience 1
or 2 disconnections.

Switching Time:
& Switch now

Switch within maintenance period ( current setting : 02:00-06:00 Modify )

@ Note:

If you want to change the maintenance window, follow these steps:

a. Click Change.

Switch Immediately After Data Migration '® Switch Within Maintenance Window ( Current Setting: 02:00-06:00)[Modify]

b. In the Configuration Information section, select a maintenance window and

click Save.
06:00-07:00 07:00-08:00 08:00-09:00 09:00-10:00
10:00-11:00 11:00-12:00 12:00-13:00 13:00-14:00
14:00-15:00 15:00-16:00 16:00-17:00 17:00-18:00
18:00-19:00 19:00-20:00 20:00-21:00 21:00-22:00
22:00-23:00 23:00-00:00 00:00-01:00 01:00-02:00
02:00-03:00 03:00-04:00 04:00-05:00 05:00-06:00
Cancel

steps to switch the service.

c. Return to the Service Availability page, refresh the page, and perform the




APIs

Operation

Description

SwnitchDBInstanceHA

Switches between the master and slave

instances.

6.5 Change the network type of an RDS for PPAS instance

This topic describes how to change the network type of an RDS for PPAS instance.

Network types

- Classic network: Instances in a classic network are not isolated. Access control is

implemented for instances by using whitelists.

- Virtual Private Cloud (VPC): A VPC is an isolated network environment. We

recommend that you use VPC because it is more secure.

You can customize the routing table, IP address range, and gateway of the VPC.
To smoothly migrate applications to the cloud, you can use a leased line or VPN
to connect your own data center to a VPC on the cloud to make a virtual data

center.

Note:

- You can use the classic network or VPC and switch between the network types

for free.

- For PostgreSQL instances, you must switch the IP whitelist mode to the

enhanced whitelist mode before switching the network type. For more

information, see #unique 54.

Switch from VPC to classic network

Precautions

- After the network type of an RDS instance is switched to classic network, the

endpoints remain unchanged, but the corresponding IP addresses change.

- After the network type of an RDS instance is switched to classic network, ECS

instances in VPCs cannot access the RDS instance by using the internal endpoint

. Make sure that you change the endpoint on the application.

- Switching the network type may result in a disconnection of 30 seconds. To avoid

impacts that arise from this operation, we recommend that you perform the




switching during off-peak hours, or configure automatic reconnection policies
for your application.

- Instances of PostgreSQL 11 High-availability Edition (cloud disk), PostgreSQL 10
High-availability Edition (cloud disk), and PostgreSQL 10 Basic Edition do not
support the classic network. Therefore, you cannot switch these instances to the

classic network.

Procedure

. Log on to the ApsaraDB for RDS console.

. In the upper-left corner, select the region where the target RDS instance is

located.

= () AlibabaCloud  cnina tHangzhou) « Q  lingManagement  More B 4ty Edsh ()

RDS instz 'ou an save data by OpenAPI for long-term queries Ignore

ApsaraDB for RDS

,_
+ 1B E iEEEEEEEEER:

Japan (Tokyo)

3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Database Connection.

5. In the Database Connection section, click Switch to Classic Network.

Instance Connection

Database Connection How to connect to RDS @

VPC [ VPCivpc-

L]

Configure Whitelist to view the internal IP address.

Mote: Use the preceding connection string to connect to the instance. You need to change the VIP in the connection 5
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6. In the message that appears, click OK.

After the network type is switched, only ECS instances in classic networks can
access the RDS instance over the internal network. Make sure that you configure
the endpoint of the RDS instance on the ECS instance in the classic network.

7. Configure the whitelist of the RDS instance to allow access from the ECS instance

over the internal network.

- If the RDS instance applies the standard whitelist mode, as shown in the
following figure, you must add the internal endpoint of the ECS instance in the

classic network to any whitelist of the RDS instance.

Whitelist Settings SOL Audit

Network isolation moded standard whitelist.{The following whitelists contain IP addresses from both classic networks and VPCs,

- If the RDS instance applies the enhanced whitelist mode, as shown in the following
figure, you must add the internal endpoint of the ECS instance in the classic
network to the default classic network whitelist of the RDS instance. If there is

no classic network whitelist, you must create a new whitelist.

Whitelist Settings SOL Audit SSL Encryption

Metwork isolation modd: enhanced whitelistd Each of the following whitelists serve a classic network or VPC.

Switch from classic network to VPC
Procedure

1. Log on to the ApsaraDB for RDSconsole.
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2. In the upper-left corner, select the region where the target RDS instance is

located.

= () Alibaba Cloud  cnina angzhou) « Q  ligansgement  More [ 4 @y egsn ()

RDS inste
ApsaraDB for RDS

RDS Mal

3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Database Connection .

5. Click Switch to VPC.

6. In the dialog box that appears, select a VPC and a VSwitch, and specify whether

to retain the classic network address.

- Select a VPC. We recommend that you select the VPC where your ECS instance

is located. Otherwise, the ECS and RDS instances cannot connect to each other



over the internal network unless Express Connect or VPN Gateway are created to
connect the two VPCs.

- Select a VSwitch. If there is no VSwitch in the VPC that you select, as shown in
the following figure, you must create a VSwitch in the zone where the instance

is located. For more information, see Manage VSwitches.

Switch to classic, include endpoint(s):

Internal in-:p rds.alivunggom
Switch to: b

VPC: N Virtual Switch: i

If the switch you need is not in the list, please create a new switch first on the VPC consale.

Reserve original classic endpoint

- Select or clear Reserve Original Classic Endpoint as needed. The following
table describes the details.

Action Description

Clear The classic network address is not retained. The original classic

network address is changed to the VPC address.

If you do not retain the classic network address, the RDS instance
will be disconnected for 30 seconds, and the access from the

ECS instance in the classic network to the RDS instance over the
internal network is immediately disconnected when you switch
the network type.




Action Description

Select The classic network address is retained, and a new VPC address is

generated, as shown in the following figure. It indicates that the
hybrid access mode is enabled, and the RDS instance can be accessed

by ECS instances in both a classic network and a VPC.

If you retain the classic network address, the RDS instance will
not be disconnected when you switch the network type. The
internal access from the ECS instance in the classic network to
the RDS instance is only disconnected when the classic network

address expires.

Before the classic network address expires, make sure that the
VPC address has been configured in the ECS instance in the VPC
to smoothly migrate your services to the VPC. The system will
send an SMS message to the phone number bound to your Alibaba
Cloud account every day in the seven days before the classic

network address expires.

Database Connection

WPC [ VPC: )

Frm- .mysql.rds.zlivuncs.com

Mote: Use the preceding connection string to connect to the instance. You need to change the VIP in the conn

Original classic endpoint (Expired and released in 14 days)

1l my=sql.rds.alivuncs.com

For more information, see Configure a hybrid access solution to smoothly

migrate an RDSinstance from the classic network to a VPC.

7. Add the internal IP address of the ECS instance in the VPC to the VPC whitelist of

the RDS instance, so that the ECS instance can access the RDS instance over the



internal network, as shown in the following figure. If there is no VPC whitelist,

you must create a new whitelist.

Whitelist Settings SQL Audit SSL Encryption

Metwork isolation moded enhanced whitelist} Each of the following whitelists serve a cassic network or VPC,

8. Perform one of the following operations as needed:

- If you retain the classic network address, you must configure the VPC address
of the RDS instance in the ECS instance that is in the VPC.

- If you do not retain the classic network address, the access from the ECS
instance in the classic network to the RDS instance over the internal network
is immediately disconnected when you switch the network type. You must
configure the VPC address of the RDS instance in the ECS instance that is in the
VPC.

)
|:| Note:
If you need to use the ECS instance in the classic network to access the RDS

instance in the VPC, you can use the ClassicLink function or migrate the ECS

instance to the VPC.
APIls
API Description
#unique_61 Used to change the network type of an
RDS instance.

6.6 Release an RDS for PPAS instance

This topic describes how to release an RDS for PPAS instance, which can use the

pay-as-you-go or subscription billing method.

O
|:| Note:




After an RDS instance is released, its data is deleted immediately. We recommend

that you back up the instance data before you release the instance.
Release a pay-as-you-go-based RDS instance

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.

o Mor: n
= (=) Alibaba Cloud a tanagen O &
RDS instz stics. You can save data by OpenAPT for long-term queries. Ignore
ApsaraDB for RDS
RDS Ma @ China (sh: Learning Path Leg Onto DB T Refresh _umlmnncs
nstances I
Cross-region Backup Basic Inf

Locked Instances (0)

fE iIEEEEEEE

0 China 5 Pay-As
o Hangzhou) P B 0 ge | M
© ZoneH
b &= ia (Kuala Lumi - VPC
China . . ) )
- Jakarts Hangzho 0 Man Subscription Billing
ZoneH "

3. Use one of the following two methods to open the Release Instance dialog box:
- Method 1:

Find the target RDS instance and in the Actions column choose More > Release

Instance.

. VPC
Jul 9, Primary China (VPCoy Pay-As-You
Running 2019, 7 "j"”j (Hangzhou) { VPLvpe- Ga"'A" ou- Manage | Change to Subscription Instance | More «
16:50 nstance Zones o - R
Change Spedifications
, Release Instance
e, China - —
Running 2019, . "_m;' (Hangzhou) vPCvpE Ga"'A" ou- Manage | Change to Subscription Instance | More =
1y A ZoneB °

- Method 2:

a. Find the target RDS instance and click the instance ID.

b. On the Basic Information page, find the Status section and click Release

Instance.

< "3 (Running) | #Back to Instances Operation Guide Log Onto DB Create Data Migration Task Restart Instance Back Up Instance CrRefresh | 1=

Basic Information ~ Distributed by Instance Role ~

status Subscripton Biling

Pay-As-You-Go Aug 14, 2019, 14:40:01
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4. In the Release Instance dialog box, click Confirm.
Release a subscription RDS instance
You can open aticket to apply for releasing a subscription RDS instance.

APIls

API Description

DeleteDBInstance Used to release a pay-as-you-go-based
RDS instance. (A subscription-based
RDS instance cannot be released by
calling an API action.)

6.7 Change the configuration of an RDS for PPAS instance

This topic describes how to change the configuration of an RDS for PPAS instance,
including changing the edition, specifications, storage capacity, storage class, and

zone.

You can upgrade or downgrade the configuration of an RDS for PPAS instance at
any time regardless of whether the instance uses the subscription or pay-as-you-go
billing method. The new configuration takes effect immediately after you complete

the configuration upgrade or downgrade.
Configuration items

If you want to horizontally scale the read capability of an RDS for PPAS instance,
you can create read-only instances. For more information, see Introduction to PPASread-

only instances and Create a PPASread-only instance.

Configurat |Description

ion item

CPU and

All PPAS DB engine versions and editions support the CPU and
Memory

memory change.



https://workorder-intl.console.aliyun.com/#/ticket/createIndex

Configurat |Description

ion item

Capacity All PPAS DB engine versions and editions allow you to increase

storage capacity.

You can only decrease the storage capacity of a subscription

instance with local SSDs during instance renewal.

Note:

- For information about the capacity range, see #unique_19.

- You cannot decrease the storage capacity if the RDS instance
uses cloud SSDs.

- If the storage capacity range of the current specifications cannot
meet your requirements, you can change the specifications.

Note:
Changing the preceding configuration does not change the endpoints of the RDS

instance.
Billing
For more information, see #unique 65.
Prerequisites
Your Alibaba Cloud account does not have an unpaid renewal order.
Precautions

When the new configuration is taking effect, the RDS instance may be disconnect
ed for about 30 seconds and most operations related to databases, accounts, and
networks cannot be performed. Therefore, we recommend that you change the
configuration during off-peak hours or make sure that your application can

automatically reconnect to the RDS instance.
Procedure

1. Log on to the RDSconsole.
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2. Select the target region.

= (-] Alibaba Cloud

ApsaraDB for RDS

Instances

Locked Instances (0) Instance

China

50N et You-Go

China o ay-As
(Hangzhou) b o8 e 0 Manage | Subscription Biling | More =

e You-Go

ZoneH

3. Find the target RDS instance and click the instance ID.
4. On the Basic information page, find the Configuration Information section and

click Change Specifications.

I Configuration Information ~
General-purpose PostgreSQL 10.0 1Cores
2048MB 1000 200
02:00-06:00 Configure rds.pg.s1.smal

5. Optional. If the RDS instance uses the subscription billing method, click Next in
the displayed dialog box.
6. On the Change Specifications page, change the instance configuration. For more

information, see Configuration items.
7. Specify the time at which you want to change the configuration.
- Switch Immediately After Data Migration: Change the configuration
immediately after the data migration.

- Switch Within Maintenance Window: Change the configuration during the

maintenance window.

-
|:_| Note:

To change the maintenance window, follow these steps:

a. Click Modify.

Switch Immediately After Data Migration [®'Switch Within Maintenance Window ( Current Setting: 02:00-06:00] [



b. In the Configuration Information section, select a maintenance window and

click Save.
06:00-07:00 07:00-08:00 08:00-09:00 09:00-10:00
10:00-11:00 11:00-12:00 12:00-13:00 13:00-14:00
14:00-15:00 15:00-16:00 16:00-17:00 17:00-18:00
15:00-19:00 19:00-20:00 20:00-21:00 21:00-22:00
22:00-23:00 23:00-00:00 00:00-01:00 01:00-02:00
02:00-03:00 03:00-04:00 04:00-05:00 05:00-06:00
Cancel

c. Go back to the Change Specifications page, refresh the page, and change the
configuration again.
8. Select Terms of Service, Service Level Agreement, and Terms of Use and click

Confirm.
FAQ

Do I need to migrate data if I only want to expand the storage capacity of an RDS

instance?

Check whether the server where the RDS instance is located provides sufficient
storage capacity for expansion. If yes, you do not need to migrate data and can
directly expand the storage capacity. If no, you must migrate data to a server that

provides sufficient storage capacity before you expand the storage capacity.

6.8 Reconfigure parameters for an RDS for PPAS instance

This topic describes how to use the console or API to view and reconfigure some
parameters for an RDS for PPAS instance. You can also use the console to query the

parameter reconfiguration history.
Precautions

- When you reconfigure parameters on the Parameters page, see the Value Range
column corresponding to each parameter.
- After you reconfigure certain parameters, you must restart the RDS instance for

the changes to take effect. For more information, see the Restart column on the



Parameters page. A restart disconnects the RDS instance. We recommend that
you make appropriate service arrangements before you restart an RDS instance.

Proceed with caution.
Reconfigure parameters

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.

= (-] Alibaba Cloud

RDS inst:

/ou can save data by OpenAPI for long-term queries. Ignore
ApsaraDB for RDS

ros Mar @ Ch
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Parameters.


https://rds.console.aliyun.com

5. On the Modifiable Parameters tab, reconfigure one or more parameters as

needed.
- To reconfigure only one parameter of the RDS instance, follow these steps:

a. Find the parameter you want to reconfigure, and in the Actual Value column

click .

rd

b. In the displayed dialog box, enter a new value within the value range and
click Confirm.
c. In the upper-right corner, click Apply Parameters.

d. In the displayed dialog box, click Confirm.

Modifizble Parameters Modification History

e

autovacuum_analyze_scale_factor 0.1 0.1 Vi 0 [0.00-0.80]

M
autovacuum_analyze_threshold 50 50 oND [1-99949]

autovacuum_freeze_max_age 200000000 200000000 # Yes [200000000-150000000...

- To reconfigure more than one parameter of the RDS instance, follow these

steps:

a. In the upper-right corner, click Export Parameters to export the parameters
as a file to your computer.

b. Open the parameter file on your computer and reconfigure the parameters.

c. In the upper-right corner, click Import Parameters.

d. Copy the parameters and their values from the parameter file and paste
them to the Import Parameters dialog box, then click OK.

e. Verify the parameter values, and click Apply Changes.



Import Parameters

b D. Ti I CRr
Click OK to preview parameter changes. After confirming that the new
parameter values are correct, click Apply Changes to save the changes.
autovacuum_analyze_scale_factor = 0.1 Refres

autovacuum_analyze_threshold = 50
autovacuum_freeze_max_age = 200000000

autovacuum_max_workers = | o o o

o

View the parameter reconfiguration history

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.
H (=] Alibaba Cloud €hina (Hangzhou) = Q  BilingManagement More [ A ¢y English f:\
,. AsaPa 4

RDS instz -
ApsaraDB for RDS B china (Hangzhou)

o
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fitics. You can save data by OpendPI for long-term queries Tonore

Instances
stances BS us (Silicon Valley)

Cross-region Backup gasic Inf B us (virginia)

Locked Instances (0)

Instance Middle Ea &2
=i India (Mumbai)
= uaE (Dubal) et =
Bl China (Chengdu) .
Bl +ong Keng China e
2017 o ( VPCvpc Pay-As- e Mo
o gingapore | 9 (Hangzhou) YouGo 0 Manage | More +
ZoneH ;
& australia (Sydney)
china rv;g < Pay-As-
(Hangzhou)  VPCRR iy 0 Manage | Subscription Billing | More «
You-Go
ZoneH
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Parameters.
5. Click the Modification History tab.

6. Select a time range and click Search.
APIls
+ #unique 67
+ #unique_68

*+ #unique 69


https://rds.console.aliyun.com/

Parameter reference

For more information, see RDSfor PPASinstance parameters.

6.9 Instance recycle bin

This topic describes the instance recycle bin and the related operations. RDS
instances are locked when they expire or have overdue payments. You can unlock,

recreate, or release instances in the recycle bin.
Renew and unlock an instance

When an RDS instance is locked due to expiration or overdue payments, you can go

to the recycle bin to renew and unlock the instance.

Instances that have been locked due to expiration or overdue payment are

described as follows:

- Subscription instances are locked and cannot be accessed within seven days
after they expire.
- Pay-as-you-go instances cannot be accessed from the second to eighth day after

your Alibaba Cloud account incurs overdue payments.
The procedure is as follows:

1. Log on to the ApsaraDB for RDS console.

2. In the upper-left corner of the page, select the region where the instance is

located.

: (=) Alibaba Cloud  ¢nina tHangzhou) « Q  BillingManagement More [ A £y  Englis ﬁ

RDS instz

ApsaraDB for RDS

RDS Ma

iEEEEEEEEE:

3. In the left-side navigation pane, click Locked Instances.

4. Find the locked instance and click Unlock to renew the instance.

The instance is unlocked after renewal.


https://www.postgresql.org/docs/10/static/runtime-config.html
https://rds.console.aliyun.com

Release an instance

When an RDS instance is locked due to expiration or overdue payments, you can

release the instance in the recycle bin.
The procedure is as follows:

1. Log on to the ApsaraDB for RDSconsole.

2. In the upper-left corner of the page, select the region where the instance is

located.
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3. In the left-side navigation pane, click Locked Instances.

4. Find the instance and click Destroy.

Q  Billing Management (2
Ls P: 0g On to DB c
Pay-s- o
You-Go
Fay-As- 0 Manage

You-Go

Subseription Billing | More
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[ Account

7.1 Create an account for an RDS for PPAS instance

This topic describes how to create an account for an RDS for PPAS instance.

Before using an RDS for PPAS instance, you must create a premier account for it in
the RDS console. Then, you can create and manage databases by using the premier

account in the DMS console.
Precautions

- The databases in an RDS instance share all resources provided by the instance
. You can create and manage one premier account and more than one standard
account by using SQL statements.

- If you want to migrate an on-premises database to an RDS instance, you must
create the same accounts and databases in the RDS instance as those in the on-
premises database.

- When assigning account permissions for each database, follow the minimum
permission' principle and consider service roles to create accounts. Alternativ
ely, rationally assign read-only and read/write permissions. When necessary,
you can split accounts and databases into smaller units so that each account can
only access data for its own services. If the account does not need to write data to
a database, assign the read-only permission for the account.

- For database security purposes, set strong passwords for the accounts and
change the passwords regularly.

- The premier account cannot be deleted after it is created.
Procedure

1. Log on to the RDSconsole


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click its ID.
4. In the left-side navigation pane, click Accounts.
5. Click Create Initial Account.

6. Enter the account information.

Create Account Back to Account Management

Database Account: root

*Password:

*Re-enter Password:

Up to 1 accounts can be created.

Cancel

Parameter description:

- Database Account: The name of the premier account. It contains 2 to 16
characters including the lowercase letters, digits, and underscores (_). It must
begin with a letter and end with a letter or digit.

- Password: The password of the premier account. It contains 8 to 32 characters

including at least three of the following types of characters: uppercase



letters, lowercase letters, digits, and special characters. The allowed special

characters are as follows:

'@#$%A&* () _+-=
- Re-enter Password: Re-enter the password to make sure that the password is
entered correctly.
7. Click OK.
8. Add the IP address that is allowed to access the RDS instance to the RDS
whitelist. For more information, see Configure a whitelist for an RDSfor PPASinstance.
9. Start the pgAdmin 4 client.

10Right-click Servers and choose Create > Server from the shortcut menu.

W pgAdmin 4 EENES

File - Object - Tools - Help -

A Browser @ Dashboard § Properties [ SQL | Statistics <y Dependencies 43 Dependents

B

& Properties . T ’ .
k! poAdmin....
- Management Tools for PostgreSQL

Feature rich | Maximises PostgreSQL | Open Source

pgAdmin is an open source adminisiration and management tool for the PosigreSQL database. The tools include a graphical
administration interface, an SQL query tool, a procedural code debugger and much more. The tool is designed to answer the
needs of developers, DBAs and system administrators alike.

Quick Links

o

Add New Server Configure pgAdmin

Getting Started

Q & -

| »
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111In the Create Server dialog box, click the General tab and enter the server name.

F Create - Server n
General Connection

Name

Server group | B Servers M
Connect now?

Comments

A
i ? Save | % Cancel & Reset

84 Issue: 20191127



12Click the Connection tab and enter the information about the instance to be

connected.

F Create - Server B

General  Connection

Host | |
namefaddress

Maintenance postgres
database

Username | |

Password

Save |:|

password?

Role

SS5L mode Prefer j

'‘Port' must be greater than or equal to 1024.

Parameter description:

- Host name/address: The internal or public endpoint of the RDS instance. To
obtain the internal and public endpoints and ports of the RDS instance, follow

these steps:

a. Log on to the RDSconsole.

b. In the upper-left corner, select the region where the target RDS instance is

located.

c. Find the target RDS instance and click the instance ID.


https://rds.console.aliyun.com/

d. On the Basic Information page, find the Basic Information section, where
you can obtain the internal and public endpoints and ports of the RDS

instance.
- Port: The internal or public port numbr of the RDS instance.
- Username: The username of the premier account for the RDS instance.
- Password The password of the premier account for the RDS instance.
13Click Save.
14Choose Servers > Server name > Databases > postgres. If the connection
information is correct, the page shown in the following figure is displayed,

indicating that a connection is established.

o

Note:

postgres is the default database of the RDS instance. Do not perform any

operation in this database.

File + Object+ Tools~  Help+
i Browser & Dashboard © Properties [ SQL |+ Statistics 4 Dependencies {3 Dependents ¥ Query-1*
B servers (1)
ow Terscionsprsecons
= [ Databases (1 3.00 250
7 Data ases (1) . WActive WCommits
|| postgres Idle 20.0| ERollbacks

48 Login/Group Roles 2.00| Total 15| MMansacions

Tablespaces 150 ' ’
100 10.0
0.50 50
0.00 0.0
2.00 2000 500

Wlinsers WFetched WReads
41 50| ®Updates 1500 | “Retumed 400| [ MiHits
WDeletes
300
1.00 1000
200
0.50 500 100
000 0 AAAI"AAAAAAAA 0
Database activity
Sessions Locks Prepared Transactions

~

~ Q

pgAdmin 4 - DB:postares 2017-07-06 16:46:52 CST active no



15Select postgres and choose Tools > Query Tool.

File - Object - TOOIS |v Help «

i Browser P & Query Tool
EF @ Servers (1)
5 W
E‘ l:J Databazes (1)
& posares
‘%’ Login/Group Roles
-- Tablespaces

#& Maintenance

X Restore

& Grant W\

160n the Query-1 tab, enter the following command to create an account:

CREATE ROLE "username" CREATEDB CREATEROLE LOGIN ENCRYPTED PASSWORD
"password';

@ Dashboard  ©f Properties [3SQL | Statistics &y Dependencies {3 Dependents  #{ Query-1*| =

> 8-a-@® 8 v [om Js-m v

postgres on doc@Alibaba Cloud RDS

1 ICREATE ROLE "test0l" CREATEDB CREATERCLE LCGIN ENCRYPTED PASSWORD 'L23=]56'|

17 Click the execute or refresh button.

@ Dashboard #f Properties [@ SQL | Statistics 4 Dependencies {3 Dependents ¥ Query-1*

P B -.-Q-. @& B @ v  .om [J[¥]-8 =z . &

postgres on doc@Alibaba Cloud RDS

1 CREATE ROLE "test(l" CREATEDE CREATERCLE LCGIN ENCRYPTED PASSWORD '12345g"



18When the command is executed successfully, indicating that the account is
created, right-click Login/Group Roles and choose the refresh button to view the

new account.

i\ Browser

= E| Servers (1)

+ Databaszes (1)

;'"‘%3 Login/Group Roles (&)

/= aurora

- 4 pg4248487
- =4 replicator

-]

ke Tablespaces
APIs
API Description
#unique_26 Used to create an account for an RDS
instance.

7.2 Reset the password of an account for an RDS for PPAS
instance
This topic describes how to reset the password of an account for an RDS for PPAS

instance in case that the password is lost.

)
|:| Note:
For data security purposes, we recommend you change the password on a regular

basis.
Procedure

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Accounts.

5. On the Accounts tab, select the account whose password you want to reset, and in

the Actions column click Reset Password.

Accounts

Accounts Service Account Permissions

Refresh Create Account

account_1 standard Account Activated database_1 Read)uirte ~  Mone

Reset Password | Modify Permissions  Delete
database_2 Read/Write y

database_1 Read/Write
" ; tivated = - Reset Password  Modify Permissions  Delete
account_2 Standard Account Activated database_2 Read/write MNone ify

superuser Privileged Account Activated ~  None Reset Password  Reset Permissions  Delete

6. In the Reset Account Password dialog box, enter a new password and confirm
it, then click OK. The password consists of 6 to 32 characters including letters,
digits, hyphen (-), or underscores (_). A previously used password is not

recommended.

APIs

API Description

#unique_74 Used to reset the password of a database
account.




8 Database

8.1 Create a database for an RDS for PPAS instance

This topic describes how to create a database for an RDS for PPAS instance.

Before using an RDS for PPAS instance, you must create a premier account for it
in the RDS console, and then create and manage databases by using the premier

account in the DMS console.
Precautions

- The databases in an RDS instance share all resources provided by the instance.
You can create and manage more than one database by using SQL statements.

- If you want to migrate an on-premises database to an RDS instance, you must
create the same accounts and databases in the RDS instance as those in the on-

premises database.
Procedure

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.

u (D Alibaba Cloud ~ cnna tsanczton « Q BimgMmagement Mre B O @y Eosn

RDS instz
ApsaraDB for RDS

RDS Mal

c 1Pk iEEEEEEEEER:
- oo g 9 5 9

apan (Tokyo)

3. Find the target RDS instance and click the instance ID.

4. Add the IP addresses of the devices that are to access the RDS instance to a
whitelist of the RDS instance. For more information, see Configure a whitelist for an

RDSfor PPASinstance.

5. Start the pgAdmin 4 client.


https://rds.console.aliyun.com/

6. In the left-side navigation pane, right-click Servers and choose Create > Server.

=e=]

W pgAdmin 4

A Browser & Dashboard &5 Properties B SQL |+ Statistics {3 Dependencies <3 Dependents

o 8 e

S

E Serer Group...
i Refresh F Serer..

& Properties .

PIAdmMIN ..

Management Tools for PostgreSQL

Feature rich | Maximises PostgreSQL | Open Source

pgAdmin is an open source administration and management tool for the PostgreSQL database. The tools include a graphical
administration interface, an SQL query tool, a procedural code debugger and much more. The tool is designed to answer the
needs of developers, DBAs and system administrators alike.

‘Quick Links

Add New Server Configure pgAdmin

Getting Started

W @ &
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7. In the Create - Server dialog box, click the General tab and enter the server

name.

F Create - Server n

General Connection

Name
Server group | E Servers o
Connect now?
Comments

i
i ? Save | 3 Cancel | &@ Reset

92 Issue: 20191127



8. Click the Connection tab and enter the information about the RDS instance to be

connected.

F Create - Server B

General  Connection

Host | |
namefaddress

Maintenance postgres
database

Username | |

Password

Save |:|

password?

Role

SS5L mode Prefer j

'‘Port' must be greater than or equal to 1024.

Parameter description:

- Host name/address: The internal or public endpoint of the RDS instance. To
obtain the internal and public endpoints and ports of the RDS instance, follow

these steps:

a. Log on to the RDSconsole.

b. In the upper-left corner, select the region where the target RDS instance is

located.

c. Find the target RDS instance and click the instance ID.


https://rds.console.aliyun.com/

d. On the Basic Information page, find the Basic Information section, where
you can obtain the internal and public endpoints and ports of the RDS

instance.
- Port: The internal or public port numbr of the RDS instance.
- Username: The username of the premier account for the RDS instance.
- Password The password of the premier account for the RDS instance.
9. Click Save.
10Choose Servers > Server name > Databases > postgres. If the connection
information is correct, the page shown in the following figure is displayed,

indicating that a connection is established.

o

Note:

postgres is the default database of the RDS instance. Do not perform any

operation in this database.
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11Select postgres and choose Tools > Query Tool.

File - Object - TOOIS |v Help «

i Browser P & Query Tool
EF @ Servers (1)
5 W
E‘ l:J Databazes (1)
[ postgres
‘%’ Login/Group Roles

7 Tablespaces

#& Maintenance

X Restore

& Grant W\

120n the Query-1 tab, enter the following command to create a database:

create database <database name>;

@ Dashboard ©f Propeties [3 SQL  |» Statistics 4y Dependencies <) Dependents  |¥ Query-1*
5 B - Q- @ B @ Y .|Noimt -f[sy . @ =z . &

1 |create database db0l; |

13 Click the execute or refresh button.

@ Dashboard  &§ Properties [# SQL |« Statistics ¢y Dependencies {2 Dependents ¥ Query-1*

slal-la- @ ® a8 v -fom |- = @ <

create database db0l;



14When the command is executed successfully, indicating that the database is
created, right-click Databases and choose the refresh button to view the new

database.

*F poAdmin 4 [=&=]

File ~ Object ~ Tools ~ Help ~
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pgAdmin 4 - DB:db01 ' 2017-07-06 16:47:41 CST idle no
pgAdmin 4 - CONN:7277567 2017-07-06 16:48:10 CST idle no -

8.2 Delete a database for an RDS for PPAS instance
This topic describes how to delete a database from an RDS for PPAS instance by

using SQL commands.
The procedure is as follows:

1. Connect your database client to the target RDS instance. For more information,

see Connect to an RDSfor PPASinstance.

2. Run the following command to delete a database:

drop database <database name>;



9 Database connection

9.1 Configure a hybrid access solution to smoothly migrate an
RDS instance from the classic network to a VPC

This topic describes how to configure a hybrid access solution to smoothly migrate
an RDS instance from the classic network to a VPC. To meet the increasing needs
of migration between different network types, ApsaraDB for RDS introduces the
hybrid access solution. This solution enables a smooth migration from the classic
network to a VPC without any transient disconnections or service interruptions.
The solution also offers the option to migrate a primary instance and its read-only

instances separately without any interference with each other.
Background information

In the past, when migrating an RDS instance from the classic network to a VPC, the
internal endpoint of the RDS instance changes. The connection string of the RDS
instance remains the same but the IP address bound to the connection string is
changed to the corresponding IP address in the VPC. This change will cause a 30-
second transient disconnection, and the ECS in the classic network cannot access
the RDS instance through the internal endpoint within this period. To migrate the
RDS instance across different networks in a smooth manner, ApsaraDB for RDS

introduces the hybrid access solution.

Hybrid access refers to the ability of an RDS instance to be accessed by ECS on both
the classic network and VPC. During the hybrid access period, the RDS instance
reserves the original internal endpoint of the classic network and adds an internal
endpoint of VPC. This prevents transient disconnections during the RDS database

migration.

For better security and performance, we recommend that you use the internal
endpoint of VPC only. Therefore, hybrid access is available for a limited period

of time. The internal endpoint of the classic network is released when the hybrid
access period expires. In that case, your applications cannot access the RDS
database by using the internal endpoint of the classic network. You must configure

the internal endpoint of VPC in all your applications during the hybrid access



period. This can guarantee smooth network migration and minimize the impact on

your services.

For example, your company wants to use the hybrid access solution to migrate RDS

instances from the classic network to a VPC. During the hybrid access period, some

applications can access the database through the internal endpoint of the VPC,

and the other applications can access the database through the original internal

endpoint of the classic network. When all the applications access the database

through the internal endpoint of the VPC, the internal endpoint of the classic

network can be released. The following figure illustrates the scenario.

Seamless migration from classic network to VP

Classic IP

RDS

-

J

Classic network

Limits

nmp

Classic network

__________________ pa—

Hybrid access period

During the hybrid access period, the instance has the following limits:

- Switching to the classic network is not supported.

- Migrating the RDS instance to another zone is not supported.



Prerequisites

- The network type of the instance is the classic network.

- Available VPCs and VSwitches exist in the zone where the RDS instance is
located. For more information about how to create VPCs and VSwitches, see

Manage VPCs.
Migrate the RDS instance from the classic network to a VPC

1. Log on to the ApsaraDB for RDS console.

2. In the upper-left corner of the page, select the region where the instance is

located.

u () Alibaba Cloud o tanganou) « Q  BilingMasgement  Moe B3 A @y Eolsn ()
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3. Find the instance and click the instance ID.

4. In the left-side navigation pane, click Database Connections.

5. Click Switch to VPC.

6. In the dialog box that appears, select a VPC and VSwitch, and select whether to

retain the internal and public endpoints of the classic network.

- Select a VPC. We recommend that you select the VPC where your ECS instance

is located. Otherwise, the ECS instance and RDS instance cannot communicate


https://rds.console.aliyun.com/

through the internal connections unless you create an express connection or

gateway. For more information, see Express connection and VPN gateway.

- Select a VSwitch. If no VSwitch exists in the selected VPC (as shown in the
following figure), create a VSwitch in the same zone as the instance. For more

information, see Manage VSwitches.

Switch to VPC

Switch to classic, indude endpoint(s):

Internal Port:  po IMCS. COM

Switch to

VPC: v Virtual Switch: v

If the switch you need is not in the list, please create a new switch first on the VPC console.

Reserve original classic endpoint

- Decide whether to select Retain Classic Network. The following table

describes the different actions.

Action Description

Clear The endpoint of the classic network is not retained. The original

endpoint is changed to the endpoint of the VPC.

If the endpoint of the classic network is not retained, a 30-second
transient disconnection will occur to the RDS instance when the
network type is changed. The internal access to the RDS instance
from the ECS instance that is located in the classic network will be
immediately disconnected.




Action Description

Select The endpoint of the classic network is retained, and a new

endpoint of the VPC is added. Indicates that the hybrid access
mode is used and RDS can be simultaneously accessed by ECS
instances both in the classic network and VPC through the

internal endpoints.

If the endpoint of the classic network is retained, the RDS
instance will not be immediately disconnected when the network
type is changed. The ECS instances in the classic network will
not be disconnected from the internal access to the RDS instance

until the internal endpoint of the classic network expires.

Before the endpoint of the classic network expires, add the
endpoint of the VPC to the ECS instance that is located in the same
VPC. This makes sure that your business is smoothly migrated

to the VPC. Within seven days before the endpoints of the classic
network expire, the system will send a text message to the mobile

phone bound to your account every day.

Database Connection

VBC [ VPC: )

m- .mysql.rds.aliyuncs.com

Mote: Use the preceding connection string to connect to the instance. You need to change the VIP in the conr

Original classic endpoint (Expired and released in 14 days)

1l my=sql.rds.alivuncs.com

7. Add the internal IP address of the ECS instance in the VPC to the VPC whitelist

group of the RDS instance. This makes sure that the ECS instance can access the



RDS instance through the internal network. If no VPC whitelist group exists,

create a new group.

Whitelist Settings SQL Audit SSL Encryption

Metwork isolation moded enhanced whitelist} Each of the following whitelists serve a cassic network or VPC,

8. - Ifyou select Retain Classic Network, add the endpoint of the VPC to the ECS
instance before the endpoint of the classic network expires.
- If you clear Retain Classic Network, the internal connection from the ECS
instance in the VPC to the RDS instance is immediately disconnected after the
network type is changed. You must add the RDS endpoint of the VPC to the ECS

instance.

il
|:| Note:
To connect an ECS instance in the classic network to an RDS instance in a VPC
through the internal network, you can use ClassicLink or switch the network type

to VPC.
Change the expiration time for the original internal endpoint of the classic network

During the hybrid access period, you can change the retention period for the
original internal endpoint of the classic network at any time as needed. The system
will update the expiration date based on the modified date. For example, if the
original internal endpoint of the classic network is set to expire on August 18, 2017
, and you change the expiration time to "14 days later" on August 15, 2017. The

internal endpoint of the classic network is released on August 29, 2017.
Follow these steps to change the expiration time:

1. Log on to the ApsaraDB for RDSconsole.


https://rds.console.aliyun.com/

2. In the upper-left corner of the page, select the region where the instance is

located.
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3. Find the instance and click the instance ID.
4. In the left-side navigation pane, click Database Connections.

5. On the Instance Connection tab, click Change Expiration Time, as shown in the

.

following figure.

I Original classic endpoint (Expired and released in 13 days) ~
rm- .mysql.singapore.rds.aliyuncs.com 3306

6. On the Change Expiration Time page that appears, select an expiration time and
click OK.



9.2 Configure endpoints for an RDS for PPAS instance

This topic describes how to configure endpoints for an RDS for PPAS instance,

including applying for, changing, and releasing the endpoints. ApsaraDB for RDS

provides two types of endpoints: internal endpoints and public endpoints.

Internal and public endpoints

Endpoint |Description
type
Internal - The internal endpoint is provided by default. You do not need to
endpoint apply for it and cannot release it. However, you can change the
network type.
- If your application is deployed on an ECS instance that is in the
same region and has the same network type as the RDS instance,
the ECS and RDS instances can communicate with each other by
default. You do not need to apply for a public endpoint for the RDS
instance.
- Accessing an RDS instance through the internal endpoint achieves
the high security and performance of the RDS instance.
Public - You must manually apply for a public endpoint. You can release the
endpoint public endpoint if you do not need it.

- When you cannot access an RDS instance through the internal
endpoint, you must apply for a public endpoint. The specific
scenarios are as follows:

- When you access an RDS instance from an ECS instance, where
the ECS instance and RDS instance are located in different
regions, and their network types are different.

- When you access an RDS instance from the third-party services
or applications.

Note:

- For security purposes, exercise caution when you access your RDS
instance through a public endpoint.

- We recommend that you migrate your application to an ECS
instance in the same region and with the same network type as
your RDS instance, and then use the internal endpoint to access
your application. This helps to improve transmission speed and
data security.




Apply for or release a public endpoint

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Database Connection.

5. - If you have not applied for a public endpoint, click Apply for Public Endpoint.
- If you have applied for a public endpoint, click Release Public Endpoint.

Database Connection -
o | Database Connection How to connect to RDS @ Switch to Cl

Monitoring and Alert... .
VPC ( VPCivpc

Data Security Configure Whitelist Configure a whitelist first.

Database Connection

Instance Connection

Connection Information How to connect to RDS @  Switch to VPC Switch Access Mode Modif
Classic Network Safe Connection Mod
Copy Address 3306
Copy Address 3306

6. In the message box that appears, click OK.
Change the internal and public endpoints

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/
https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Database Connection.
5. Click Change Endpoint.
6. In the dialog box that appears, specify the internal and public endpoints, and
click OK.
Change Endpoint
Connection Type: Public Endpoint v
Endpoint: rm-1ludy3ogi42m42a8lfio | .pg.rds.aliyuncs.com
Port: 3433

n Cancel
@ Note:



- The prefix of the endpoint must be 8 to 64 characters in length and can
contain letters, numbers, and hyphens (-). It must start with a lowercase
letter.

- In a VPC, either the internal port number or public port number cannot be
changed.

- In a classic network, either the internal port number or public port number

can be changed.

APIs
Operation Description
#unique_84 Used to apply for a public endpoint for
an RDS instance.
#unique_85 Used to release the public endpoint of
an RDS instance.

9.3 Use DMS to log on to an ApsaraDB for RDS instance

You can use DMS to log on to an ApsaraDB for RDS instance.
Precautions

Currently, you can only use an internal endpoint to log on to DMS.
Procedure

1. Log on to the ApsaraDB for RDS console.

2. In the upper-left corner of the page, select the region where the target instance is

located.
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3. Click the ID of the instance to go to the Basic Information page.


https://rds.console.aliyun.com/

4. Click Log On to DB in the upper-right corner of the page, as shown in the
following figure, to go to the Quick Logon page of the DMSconsole.

' rm- (Running) | #Back to Instance List

Operation Guide Restore Database to RDS for PolarDB Instance Migrate to RDS for PolzarDB Instznce Log On to DB Create Data Migration Task Restart Instance

5. On the Quick Logon page, set the following parameters:

- The endpoint and port number of the instance in the <Internal
endpoint>:<Internal port number> format. Example: rm-
bpxxxxxxx.rds.aliyuncs.com:3433. For details about how to view the internal
endpoint and port number of an instance, see View the internal and public endpoints
and ports of an RDSfor PPASinstance.
- Database username: the account used to access the instance.

- Password: the password of the account used to access the instance.

€ RDS Database LOgON  eesensen o -

Remember Password

Log On

6. Click Log On.

@ Note:

If you want the Web browser to remember the password, select Remember
Password and click Log On.
7. If the system prompts you to add the CIDR block of the DMS server to the
ApsaraDB for RDS whitelist, click Specify for All Instances or Specify for Current

Instance.


https://dms.console.aliyun.com/?spm=5176.doc49015.2.5.1qi2e9&token=549cf345-ac05-455c-b3f9-75eadae023fe#/dms/login

8. Click Log On.

9.4 View the internal and public endpoints and ports of an RDS
for PPAS instance

This topic describes how to view the internal and public endpoints and ports of an
RDS for PPAS instance in the RDS console. When connecting to an RDS instance,

you must enter its internal or public endpoint and port number.
Procedure

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.
4. On the Basic Information page, find the Basic Information section, where you can

view the internal and public endpoints and ports of the RDS instance.

- The internal and public endpoints are displayed only after you configure a

whitelist.


https://rds.console.aliyun.com/

- The public endpoint is displayed only after you apply for it.

Basic Information Configure Whitelist Migrate Across Zones A
rm-1ud1nzb7781830y1e rm-1udinzb7781830yle #

Primary igh-
China (Hangzhou)ZoneH ance 1) rimary Instance (High
availability)

) ]

Local SSD

3306

Apply for a Read/Writer Spliting Address

9.5 Apply for a public endpoint for an RDS for PPAS instance
This topic describes how to apply for a public endpoint for an RDS for PPAS

instance. Apsara for RDS supports two types of endpoints: internal endpoints and
public endpoints. By default, the system provides you with an internal endpoint
for connecting to your RDS instance. If you want to connect to your RDS instance

through the Internet, you must apply for a public endpoint.

Internal and public endpoints

Endpoint |Description

type

Internal

‘ The internal endpoint is generated by default.
endpoint

Use the internal endpoint if all of the following conditions are met:

- Your application is deployed on an ECS instance.
- The ECS instance is located in the same region as your RDS instance

- The ECS instance has the same network type as your RDS instance.

We recommend that you use the internal endpoint to access your
RDS instance because this is more secure and delivers optimal
performance.




Endpoint
type

Description

Public
endpoint

You must manually apply for a public endpoint. You can also release it
anytime.

Use the public endpoint if you cannot access RDS through the intranet

. Specific scenarios are as follows:

- An ECS instance accesses your RDS instance but the ECS instance is
located in a different region or has a network type different from
your RDS instance.

- A server or computer outside Alibaba Cloud accesses your RDS
instance.

Note:

- The public endpoint and traffic are currently free of charge.

- Using the public endpoint reduces security. Please exercise
caution.

- To guarantee high security and performance, we recommend that
you migrate your application to an ECS instance that is in the same
region and has the same network type as your RDS instance and
then use the public endpoint.

Procedure

1. Log on to the RDSconsole.

2. Select the target region.
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Database Connection.


https://rds.console.aliyun.com/?spm=5176.doc43185.2.7.mR2Syx

5. Click Apply for Public Endpoint.

< < ... (Ruming) [ 2Back to Instance List Operation Guide Log On to DB Create Data Migration Task Restart Instance Back Up Instance C Refresh

Basic Information o
Connection Options

Accounts
Instance Connection  Read/Write Splitting
Databases
Database Connection . .
I Database Connection How to connect to RDS @ Switch to Classic Network Change Endpoint Apply for Public Endpoint 2
Ry VRC ( ) Diszbled
toring and Alet... .
Moniiering 2nd Alet Configure Whitsiist to view the internal 17 address. 3306
Data Security
Connection Architecture ther Connection Architecture A
Service Availablity = I ! T Other Connection Architectr

6. In the displayed dialog box, click OK.

A public endpoint is generated.

7. Optional. If you want to change the public endpoint or port number, click Change
Endpoint. In the displayed dialog box, set the public endpoint and port number
and click OK.

- Connection Type: Select Public Endpoint.

il
|:| Note:



The Public Endpoint option is available only after you have applied for a

public endpoint.

- Endpoint: The endpoint must be 8 to 64 characters in length and can contain

letters, numbers, and hyphens (-). It must start with a lowercase letter.

- Port: You can change the port number only when the network type of the RDS

instance is classic network.

Change Endpoint

Connection Type: Public Endpaint v
Endpoint: m-1udka9920x4ss6gpove | -Sqlserver.rds.aliyuncs.com
Port:
APIls
API Description
#unique_84 Used to apply for a public endpoint for
an RDS instance.




10 Monitoring and alerts

10.1 View resource monitoring data

This topic describes how to view the resource and engine monitoring data of an
RDS for PPAS instance. ApsaraDB for RDS provides a wide range of performance

metrics for you to view in the RDS console.
Procedure

1. Log on to the RDSconsole.
2. In the upper-left corner, select the region where the target RDS instance is
located.
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Monitoring and Alerts.

5. On the Monitoring tab, specify the time range. The following table describes the

monitoring metrics.
Metric Description
Disk Space (MB) The disk space usage of the RDS instance. Unit:
MByte.
IOPS (Input/Output The number of I/0 requests to the data disk per

Operations per Second) |second and the number of I/0 requests to the log
disk per second for the RDS instance. Unit: Number/
second.

Memory Usage (%) The memory usage of the RDS instance.

CPU Utilization (%) The CPU usage of the RDS instance.



https://rds.console.aliyun.com/

Metric

Description

Total Connections

The total number of connections to the RDS instance

10.2 Set the monitoring frequency

This topic describes how to set the monitoring frequency for an RDS for PPAS

instance.

Background information

RDS for PPAS supports two monitoring frequencies:

- Once per 60 seconds (monitoring period: 30 days)

-+ Once per 300 seconds (monitoring period: 30 days)

Procedure

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Monitoring and Alerts.

-

Note:

For information about the monitoring metrics supported by the instance, see

View resource monitoring data.

5. Click the Monitoring tab.

6. Click Set Monitoring Frequency.



https://rds.console.aliyun.com/

7. In the Set Monitoring Frequency dialog box, select the monitoring frequency and

click OK.
n Cancel
APIs
API Description
#unique_92 Used to query the monitoring data of an
RDS instance.

10.3 Set an alert rule

This topic describes how to set an alert rule for an RDS instance. ApsaraDB for
RDS offers the instance monitoring function, and sends messages to you after
detecting an exception in an instance. In addition, when the instance is locked due

to insufficient disk space, the system sends a message to you.
Background information

Alibaba CloudMonitor offers monitoring and alarming. CloudMonitor helps you set
alarm rules for metrics. You must add alarm contacts while set a contact group. The
alarm contacts and the contact group are notified immediately when an alarm is
triggered in the event of exceptions. You can create an alarm contact group using a

related metric.
Procedure

1. Log on to the RDSconsole.



https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Monitoring and Alerts.
5. Click the Alerts tab.

6. Click Set Alert Rule.

You are directed to the CloudMonitor console.

Note:
You can click Refresh to manually refresh the current status of the alert metrics.
7. In the left-side navigation pane, choose Alarms > > Alarm Contacts to open the

Alarm Contact Management page.

Note:

When alert rules are set for the first time, if the alert notification object is not
a contact of the Alibaba Cloud account of RDS, the alarm contact and alarm
contact group must be created first. If you have already set the alarm contact
and the alarm contact group, go to Step 10.

8. Click Create Alarm Contact.

9. In the Set Alarm Contact dialog box, enter the alarm contact information and

click Send verification code. Then, enter the verification code sent to your

mailbox, and click Save.

Note:

- We recommend that you perform the next step to create the alarm contact

group after you add all alarm notification objects.



- You can click Edit to modify a contact, or click Delete to delete a contact.
100n the Alarm Contact Management page, click the Alarm Contact Group tab.
11Click Create Alarm Contact Group.
12Set Group Name and Description, select a contact from Existing Contacts, click

to add the contact to Selected Contacts, and click OK.

Note:

On the Alarm Contact Group page, you can click to modify a contact

y;

group, click X to delete a contact group, or click Delete to delete a contact in the
contact group.

13 After creating the alarm contact group, choose Cloud Service Monitoring >

ApsaraDB for RDS from the left-side navigation pane.
14 Select the region of RDS for which the alert rule is to be set.

15Find the target instance and click Alarm Rules in the Actions column.

The system displays the metrics of the current alert.

16Click Create Alarm Rule to add a new alert rule.

Note:

You can click Modify, Disable, or Delete for the metrics as needed.



11 Data security

11.1 Switch to the enhanced whitelist mode for an RDS for PPAS
instance

This topic describes how to switch from the standard whitelist mode the enhanced

whitelist mode for an RDS for PPAS instance.
IP whitelist modes
ApsaraDB for RDS instances provide the following two IP whitelist modes:
- Standard whitelist mode

In this mode, the IP addresses in the whitelist do not distinguish between classic
networks and VPCs. The IP addresses in the whitelist can access the RDS instance
both in classic networks and VPCs. We recommend that you switch from the

standard whitelist to the enhanced whitelist.

FCCOUTTCS

Whitelist Settings SOL Audit
Backup and Restorati...

Database Connection Network isolation mode: standard whitelist, The following whitelists contain IP addresses from both classic networks and VPCs,

Monitoring and Alert...

- Enhanced whitelist mode

In this mode, the whitelist is classified into two IP whitelist groups by network
type: the classic-network whitelist group and the VPC whitelist group. When you

create an IP whitelist, you must specify a network type.

Accounts

Whitelist Settings SQL Audit
Backup and Restorati...

fwork i - nade: ced whitelist ch o wing whitali 2y 5 twork or VI
TeieiEen EEET Network isolation mode: enhanced whitelist. Each of the following whitelists serve a classic network or VPC,

Monitoring and Alert...
Service Availability
Logs

¥ (ClandnBRA



Changes after switching to the enhanced whitelist mode

- If the network type of the instance is VPC, a new whitelist of the VPC is generated
and contains the same IP addresses in the original whitelist. The new IP whitelist
group only applies to VPCs.

- If the instance network type is classic network, a new whitelist group is
generated and contains the same IP addresses in the original whitelist. The new
IP whitelist group only applies to classic networks.

- If the instance is in the hybrid access mode, two new whitelist groups are generated
and each contains the same IP addresses in the original whitelist. One of the

whitelist group applies to VPCs and the other applies to classic networks.

Note:
Switching to the enhanced whitelist mode does not affect the ECS instances that are

in the ECS security group whitelist.
Precautions

- You can switch from the standard whitelist mode to the enhanced whitelist mode
. However, you cannot switch from the enhanced whitelist mode to the standard
whitelist mode.

- In the enhanced whitelist mode, the classic-network whitelist group also applies
to accesses from a public network. If you want to access the RDS instance from
an instance, host, or application in the public network, you must add the public

IP address to the classic-network whitelist group.
Procedure

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Data Security.

5. On the Whitelist Settings tab, click Switch to Enhanced Whitelist
(Recommended).

Security

Whitelist Settings SQL Audit SQL TDE

Network Isolation Mode: Standard Whitelist. The whitelist does not differentiate between classic networks and VPC networks.

127.0.0.1

6. In the message box that appears, click OK.

11.2 Configure a whitelist for an RDS for PPAS instance

This topic describes how to configure a whitelist for an RDS for PPAS instance.

After you create an RDS instance, you must configure a whitelist to allow external
devices to access the instance. The default whitelist contains only the default IP
address 127.0.0.1. Before you add new IP addresses to the whitelist, no devices can

access the RDS instance.

A whitelist can be used to improve the security of your RDS instance. We
recommend that you update the whitelist on a regular basis. Configuring a whitelist

does not affect the normal operation of your RDS instance.



Precautions

- The default whitelist can only be edited or cleared, but cannot be deleted.

- If you log on to DMS but your IP address has not been added to the whitelist,
DMS prompts you to add the address and automatically generates a whitelist
containing your IP address.

- You must confirm which network isolation mode the instance is in before
configuring a whitelist. Refer to the corresponding operations based on the

network isolation mode.

Data Security

Basic Information

Whitelist Settings
Metwork isolation mode: standard whitslist. The following whitslists contain 17 addresses from both classic networks and VRCs.
ear

127.0.0.1

Service Availability Whitelist Settings Description

Note:
The internal networks to which RDS instances belong are divided into two types:

classic network and VPC.

- Classic network: Alibaba Cloud allocates IP addresses automatically. Users only
need to perform simple configurations. This network type is suitable for new

users.

- VPC: Users customize the network topology and IP addresses. It supports leased

line connection, and is suitable for advanced users.
Procedure
Enhanced whitelist

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Data Security.
5. On the Whitelist Settings tab page, follow the following instructions based on

your usage scenario:
- Accessing an RDS instance from an ECS located in a VPC: Click Edit next to the
default VPC whitelist.

- Accessing an RDS instance from an ECS located in a classic network: Click Edit

next to the default Classic Network whitelist.

- Accessing an RDS instance from an ECS or host located in a public network:

Click Edit next to the default Classic Network whitelist.

-
|:| Note:

- If the ECS instance accesses the RDS instance by using the VPC or classic
network, you must make sure that the two instances are in the same region

and have the same network type. Otherwise, the connection fails.

- You can also click Create Whitelist. In the displayed Create Whitelist dialog
box, select VPC or Classic Network/Public IP.

rvice Avalabilty Security Group

.




6. Specify IP addresses or CIDR blocks used to access the instance, and then click
OK.

- If you specify the CIDR block 10.10.10.0/24, any IP addresses in the 10.10.10.x
format are allowed to access the RDS instance.
- To add multiple IP addresses or CIDR blocks, separate each entry with a

comma (without spaces), for example, 192.168.0.1,172.16.213.9.

- After you click Add Internal IP Addresses of ECS Instances, the IP addresses of
all the ECS instances under your Alibaba Cloud account are displayed. You can

quickly add internal IP addresses to the whitelist.

Note:



ApsaraDB for RDS RDS for PPAS Database / 11 Data security

After you add an IP address or CIDR block to the default whitelist, the default
address 127.0.0.1 is automatically deleted.

Edit Whitelist

Network Type: VPC ' Classic Network/Public IP
You currently cannot configure network isolation settings. You must
enable enhanced whitelists first before configuring network isolation
settings.

Whitelist Name™: default

Whitelist™*: 127.0.0.1

Add Internal IP Addresses of ECS Instances
You can add 999 more entries.

Spedified IP address: If you specify the IP address
192.168.0.1, this IP address is allowed to access the RDS
instance.

Spedified CIDR block: If you specify the CIDR block
192.168.0.0/24, the IP addresses ranging from 192.168.0.1 to
192.168.0.255 are allowed to access the RDS instance.

When you add multiple IP addresses or CIDR blocks, separate
them by a comma (no space after the comma), for example,
192.168.0.1,192.168.0.0/24.

How to Locate the Local IP Address

MNew whitelist entries take effect in 1 minute.

Standard whitelist

1. Log on to the RDSconsole.

Issue: 20191127 125


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is
located.
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Data Security.
5. On the Whitelist Settings tab page, click Edit corresponding to the default
whitelist.
)
[:] Note:

You can also click Create Whitelist to configure a whitelist.

Whitelist Settings SQL Audit SSL Encryption

Network isolation mods: standard whitzlist. The following whitelists contain IP addresses from both classic networks and VPCs. Enable Enhanced Whitslist (Recommended)
e

127.0.0.1

Whitelist Settings Description

6. In the displayed Edit Whitelist dialog box, specify the IP addresses or CIDR

blocks used to access the instance, and then click OK.

- If you specify the CIDR block 10.10.10.0/24, any IP addresses in the 10.10.10.x
format are allowed to access the RDS instance.

- To add multiple IP addresses or CIDR blocks, separate each entry with a
comma (without spaces), for example, 192.168.0.1,172.16.213.9.

- After you click Add Internal IP Addresses of ECS Instances, the IP addresses of
all the ECS instances under your Alibaba Cloud account are displayed. You can
quickly add internal IP addresses to the whitelist.

3

[:] Note:



After you add an IP address or CIDR block to the default whitelist, the default
address 127.0.0.1 is automatically deleted.

Edit Whitelist

Network Type: WPC Classic Network/Public IP
You currently cannot configure network isolation settings. You must
enable enhanced whitelists first before configuring network isolation
settings.

Whitelist Name™: default

Whitelist™: 127.0.0.1

Add Internal IP Addresses of ECS Instances |
You can add 999 more entries.

How to Locate the Local IP Address

Common errors

- The default address 127.0.0.1 on the Whitelist Settings tab indicates that no
device is allowed to access the RDS instance. Therefore, you must add IP

addresses of devices to the whitelist to allow access to the instance.

- The IP address in the whitelist is set to 0.0.0.0, but the correct format is 0.0.0.0/0.

% Note:



APIs

0.0.0.0/0 indicates that all devices are allowed to access the RDS instance.

Exercise caution when using this IP address.

- If you turn on the enhanced whitelist mode, you must make sure that:

- If the network type is VPC, the internal IP address of the ECS instance is added

to the whitelist whose network isolation mode is VPC.

- If the network type is classic network, the internal IP address of the ECS
instance is added to the whitelist whose network isolation mode is classic
network.

- Ifyou are connecting to the RDS instance through ClassicLink, the internal IP
address of the ECS instance must be added to the default VPC whitelist.

- If you are connecting to the RDS instance through a public network, the
public IP address of the instance or host must be added to the whitelist whose
network isolation mode is classic network.

- The public IP address that you add to the whitelist may not be the real egress IP

address. The reasons are as follows:

- The public IP address is not fixed and may dynamically change.
- The tools or websites used to query the public IP addresses provide wrong IP

addresses.

For more information, see #unique 23

API Description

#unique_24 Used to view the IP address whitelist of
an RDS instance.

#unique 25 Used to modify the IP address whitelist
of an RDS instance.



https://www.alibabacloud.com/help/zh/doc-detail/65412.htm
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13 Data backup

13.1 Back up the data of an RDS for PPAS instance

This topic describes how to back up the data of an RDS for PPAS instance. You can

specify a data and log backup cycle, according to which the system automatically

backs up data and logs. Alternatively, you can manually back up the instance data.

Precautions

- The backup files occupy the backup space of the RDS instance. If the used

backup space exceeds the quota of free backup space, additional fees are

incurred. For more information, see View the quota of free backup space for an RDS for

PPAS instance.

- For information about the billing method and billable items, see #unique_15.

- For information about the pricing of backup space, see ApsaraDB RDS for MySQL

pricing.

- Do not perform DDL operations during the backup. Otherwise, tables are locked

and consequently the backup fails.

- Back up data and logs during off-peak hours.

- If the data volume is large, the backup may take a long time.

- Backup files are retained for a specified time period. Download the backup files

to your computer before they are deleted.

Overview
DB engine | Data backup Log backup
PPAS Supports full physical backup. A WAL file (16 MB/file) is

compressed and uploaded
immediately after it is generated.
You must delete the file from your
computer within 24 hours.

Set a backup policy for automatic backup

ApsaraDB for RDS can automatically back up databases according to the backup

policy you set.



https://www.alibabacloud.com/product/apsaradb-for-rds#pricing
https://www.alibabacloud.com/product/apsaradb-for-rds#pricing

1. Log on to the RDSconsole.

2. Select the target region.
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Backup and Restoration.

5. On the Backup and Restoration page, click the Backup Settings tab. On the
Backup Settings tab, click Edit.

6. In the Backup Settings dialog box, set the backup parameters and click OK. The

following table describes the parameters.

Table 13-1: Backup parameters

Parameter

Description

Data

The data retention period spans from 7 days to 730 days. The default

Retention |retention period is 7 days.
Period
Note:
For MySQL 5.7 Basic Edition (with SSDs), the data retention period
is 7 days and cannot be changed.
Backup Select one or more workdays.
Cycle
Backup |You can select any time period, which is measured in the unit of
Time hour. We recommend that you select a time period during off-peak
hours.
Log The status of the log backup function.
Backup

Notice:
If you disable the log backup function, all log backup files are
deleted and the time-based data restoration function becomes
unavailable.



https://rds.console.aliyun.com

Parameter

Description

Log
Retention
Period

- The number of days in which log backup files are retained. The
default retention period is 7 days.

- The log retention period spans from 7 days to 730 days and must
be shorter than or equal to the data retention period.

[% Note:

For MySQL 5.7 Basic Edition (with SSDs), the log retention period is
7 days and cannot be changed.

Backup Settings

Data Retention 7 Days
Period
Backup Cycle #| Monday # Tuesday [ Wednesday [ Thursday

#| Friday # Saturday | Sunday

Backup Time 04:00-05:00 M
Log Backup ® Enable Disable
Log Retention Period 7 Days
Pricing

Manually back up data

1. Log on to the RDSconsole.



https://rds.console.aliyun.com

2. Select the target region.
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3. Find the target RDS instance and click the instance ID.

4. In the upper-right corner of the Basic Information page, click Back Up Instance.

Back Up Instance

Select Backup
Mode: Full Backup v

Backup Policy: '® Instance Backup

Are you sure you want to back up the instance immediately? (The backup task will start in
approximately 1 minute.)

5. In the Back Up Instance dialog box, set the backup parameters and click OK.
FAQ
1. Can I disable the data backup function for an RDS for PPAS instance?

No, the data backup function must be enabled. However, you can lower the
backup frequency to at least two times a week. The backup file retention period
ranges from 7 days to 730 days.

2. Can I disable the log backup function for an RDS for PPAS instance?

Yes, you can disable the log backup function as needed.



APIs

API Description

#unique_100 Used to create a backup file for an RDS
instance.

#unique 101 Used to view the list of backup files for

an RDS instance.

#unique_102 Used to view the backup settings of an
RDS instance.

#unique_103 Used to modify the backup settings of an
RDS instance.

#unique_104 Used to delete the data backup files of
an RDS instance.

#unique_105 Used to obtain the list of backup tasks
for an RDS instance.

#unique_106 Used to obtain the log backup files of an
RDS instance.

13.2 View the quota of free backup space for an RDS for PPAS
instance

This topic describes how to calculate and view the quota of free backup space
for an RDS for PPAS instance. The quota varies depending on the used DB engine
version and edition. Additionally, this topic describes how to calculate the backup

space beyond the quota.

Backup files occupy backup space. Each RDS instance has a specific quota of free
backup space. If the total size of backup files exceeds the quota, additional fees are

incurred.

Calculate the quota of free backup space and the backup space beyond the quota

Quota of free backup space = Round up (50% X Storage space purchased for the
RDS instance) (Unit: GB)

Backup space beyond the quota = Backup data size + Backup log size - Round up (50
% X Storage space purchased for the RDS instance) (Unit: GB)



For example, the backup data size is 30 GB, the backup log size is 10 GB, and the

storage space is 60 GB, then you must pay for 10-GB storage space every hour:

Hourly fees = 30 + 10 - 50% x 60 = 10 (GB)

E] Note:

- For more information about the hourly fees for the backup space beyond the

quota, see ApsaraDB RDSfor MySQL pricing.

- The Basic Editions of some DB engines store backup files generated within the

last seven days for free. For more information, log on to the RDS console.

I Basic Information Configure Whitelist Migrate Across Zones A I Distributed by Instance Role

’
Read-only Instance

China (Hangzhou)ZoneH+Zone Primary Instance (High-availabilty)

0 view the internal IP address. 3433

Apply for public Endpoint ou can create read-only instances only for

Local s5D

Note: Use the preceding connection siring to connect to the instance., You need to change the VIP in the connection string to the ene used in your environment.

I Status Renew
Running Monthly subscription will expire in 24 day(s) Jul 1, 2019, 16:49:40
I Configuration Information Change Specfications
General-purpose 1Cores
2048118 1000 200
02:00-06:00 Configure rdspa.si.smal

I Usage Statistics

Used 103.00M (Capacity:55.00G) | Data Size: 26.08M; Log Size: 4.56M(Fr

View the quota of free backup space in the RDS console

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.

= () Alibaba Cloud

RDS instz 1 can save data by OpeniPI for long-term queries Ignore

ApsaraDB for RDS China (Hangzhou)

RDS Mal

EEEE:

Locked Instances (0)

o o

-

@ china

- - (Hangzhou) Pee Farne 0 o

ON : Vo

ZoneH

L]

= & a VPC

= nina

- Hangzh i ; o Mzn
ZoneH "

3. Find the target RDS instance and click its ID.


https://www.alibabacloud.com/product/apsaradb-for-rds?spm=a3c0i.7938564.220486.8.4nCrkf#pricing
https://rds.console.aliyun.com/

4. In the Usage Statistics section of the Basic Information page, view the data size

next to Space Used for Backup. The data size is the quota of free backup space.

Note:
The quota of free backup space varies depending on the instance type. The

following figure is only an example.

I Usage Statistics
Used 1.20G (Capacity:60.00G) Data Size: 6.47M; Log Size: 50.73M(Free quota for backup is 30720 M2.) View Details

0.00K View Details

13.3 Download the backup files of an RDS for PPAS instance

This topic describes how to download the log backup files of an RDS for PPAS

instance. The downloaded log backup files are not encrypted.

Note:

An RDS for PPAS instance does not support the download of data backup files. You
can restore the data of an RDSfor PPASinstance or migrate data from RDS for PPAS to an

on-premises database.
Limits
A RAM user who has only the read-only permissions cannot download backup files.

You can add the required permissions to a RAM user in the RAM console. For more

information, see #unique_109.

DB engine | Data backup download Log backup download
PPAS Not supported. Supported by all versions.
Procedure

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.

= (-] Alibaba Cloud

RDS instz You can save data by OpendPI for long-term queries Tonore

ApsaraDB for RDS

RDS Mal
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3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Backup and Restoration.

Basic Information i
Backup and Restoration

Accounts

Data Backup Archive List Backup Settings
Databases

Backup and Restorati... Select Time Range Nov 13, 2019 To | Mov 20, 2019 m

Database Connection

Database Proxy
Nov 20, 2019, 08:09~Nov 20, 2019, 08:10 Instance Backup

Monitoring and Alert...

5. On the Archive List tab, select a time range and click Search. In the log backup

file list, find the target log backup file and in the Actions colum click Download.

E] Note:

If the log backup file is used to restore the RDS instance to an on-premises

database, note the following:

- The Instance No. of the log backup file must the same as that of the
corresponding data backup file.

- The start time and end time of the log backup file must be later than the
selected backup time point and earlier than the time point from which you

want to restore data.



6. In the Download Instance Backup Set or Download Binary Log dialog box, select

a download method.

Download Instance Backup Set

We currently offer free downloads of backup sets for a limited period of time.

If your ECS and RDS instances are in the same region, accessing an internal download URL to download backup sets increases the level

of security and download speed.

Methods to Download and Restore from Backup Sets

Copy Internal Download URL Copy External Download URL Cancel

Download Method

Description

Download

To download the backup file through
the public connection address.

Copy Internal Download URL

To copy the internal download URL
only. When your ECS instance is
located in the same region as the RDS
instance, you can log on to your ECS
instance and then use the internal
download URL to download the backup
file. This is faster and more secure.

Copy External Download URL

To copy the external download URL
only. This method is suitable when
you download the backup file by using
other tools.

Note:

In a Linux operating system, you can run the following command to download a

log backup file:

wget -c '<Download URL of the log backup file>' -0 <User-defined

file name>.tar.gz

- The -c parameter is used to enable resumable download.

- The -0 parameter is used to save the downloaded result as a file with the

specified name (the file extension is .tar.gz or .xb.gz as included in the URL).




- If you enter more than one download URL, then you must include each
download URL in a pair of single quotation marks ("). Otherwise, the

download fails.



14 Data restoration

14.1 Restore the data of an RDS for PPAS instance

This topic describes how to restore the data of an RDS for PPAS instance by using a

data backup.

You can restore the data of an RDS for PPAS instance by backup set or time. The

process is as follows:

1. Restore data to a new RDS instance.
2. Verify data in the new RDS instance.

3. Migrate data to the original RDS instance.
Precautions

- The whitelist settings, backup settings, and parameter settings of the new RDS

instance must be the same as those of the original RDS instance.
- The data information of the new RDS instance must be the same as that of the

used backup file or that from the specified time point.

- The new RDS instance carries the account information in the used backup file or

that from the specified time point.
Fees
For more information, see ApsaraDB RDSfor MySQL pricing.
Prerequisites
The original RDS instance must meet the following conditions:

- The instance is in the Running state and is not locked.
- No migration task is being performed for the instance.

- If you want to restore the data from a time point, the log backup function is

enabled.

- If you want to restore the data from a backup set, at least one backup set is

available for the instance.
Restore data to a new RDS instance

1. Log on to the RDSconsole.


https://www.alibabacloud.com/product/apsaradb-for-rds#pricing
https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.

u (-] Alibaba Cloud

ApsaraDB for RDS

RDS inst:

RDS Mal
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3. Find the target RDS instance and click its ID.

4. In the left-side navigation pane, click Backup and Restoration.

5. In the upper-right corner, click Restore Database (Previously Clone Database).

6. On the displayed Restore Database (Previously Clone Instance) page, select a
billing method:

- Pay-As-You-Go: Fees are calculated by hour according to the actual job size.

This billing method is suitable to a short-term RDS instance, which can be

released immediately after you finish the data restoration.

- Subscription: Fees are estimated in advance, and the relevant usage allocation

is paid for when you create an RDS instance. This billing method is suitable

to a long-term RDS instance, which is cheaper than a pay-as-you-go instance.

Additionally, a longer duration of purchase indicates a higher discount rate.

-

Note:

You can change the billing method of an RDS instance from pay-as-you-go to

subscription but not from subscription to pay-as-you-go.



7. Set the parameters of the new RDS instance.

Parameter

Description

Restore
Mode

- By Time: You can select any time point within the specified log
backup retention period. For more information about how to
view or change the log backup retention period, see Back up the data
of an RDSfor PPAS instance.

- By Backup Set

Note:
The By Time option is available only when the log backup function
is enabled.

Zone

A zone is a physical area within a region. Different zones in the same
region are basically the same.

You can create an RDS instance in the same or different zone from
the corresponding ECS instance.

Note:
The new RDS instance must be located in the same region as the
original RDS instance.




Parameter

Description

CPU and
Memory

The type (including the CPU and memory specifications) of the new
RDS instance. The CPU, memory, and storage capacity specificat
ions of the new RDS instance must be higher than hose of the
original RDS instance. Otherwise, the data restoration may take a

long time.

Each instance type supports a specific number of CPU cores,
memory size, maximum number of connections, and maximum

IOPS. For more information, see #unique 19.
RDS instances fall into the following three type families:

- General-purpose instance: A general-purpose instance owns
dedicated memory and I/0 resources, but shares CPU and storage
resources with the other general-purpose instances on the same
server.

- Dedicated instance: A dedicated instance owns dedicated CPU,
memory, storage, and I/0 resources.

- Dedicated host: A dedicated-host instance owns all the CPU,
memory, storage, and I/0 resources on the server where it is
located.

For example, 8 Cores, 32 GB indicates a general-purpose instance,
8 Cores, 32 GB (Dedicated Instance) indicates a dedicated instance,

and 30 Cores, 220GB (Dedicated Host)30 Cores, 220 GB (Dedicated
Host) indicates a dedicated-host instance.

Capacity

Used for storing data, system files, binlog files, and transaction files.

Network
Type

- Classic Network: a classic network.

- VPC (recommended): A VPC is an isolated network environment
that provides better security and performance than a classic
network.

8. Optional. If the new RDS instance uses the subscription billing method, set the

Duration and Quantity parameters.

9. Click Buy Now.

100n the Order Confirmation page, select Terms of Service, Service Level

Agreement,

and Terms of Use, then click Pay Now to complete the payment.




Verify data in the new RDS instance
For more information, see Connect to an RDSfor PPASinstance.
Migrate data to the original RDS instance

After verifying the data in the new RDS instance, you can migrate the data to the

original RDS instance.

Data migration refers to migrating data from one RDS instance (the source RDS
instance) to another (the destination RDS instance). The data migration operation

does not interrupt the source RDS instance.
Precautions

Do not perform DDL operations during the data migration. Otherwise, the data

migration may fail.
Procedure

1. Log on to the DTSconsole.
2. In the left-side navigation pane, click Data Migration.

3. In the upper-right corner, click Create Migration Task.


http://dts.console.aliyun.com/

4. Enter the migration task name, source database information, and destination

database information.
Parameter description:

- Task Name: By default, DTS automatically generates a name for each
migration task. You can change the name as needed.

- Source Database

- Instance Type: Select RDS Instance.

- Instance Region: Select the region where the new RDS instance is located.

- RDS Instance ID: Select the ID of the new RDS instance.

- Database Account: Enter the username of the account for the new RDS
instance.

- Database Password: Enter the password of the account for the new RDS

instance.

- Connection: Select Non-encrypted. If the new RDS instance supports
S3. encryption and has SSL encryption enabled, then you must select SSL-
encrypted.

Note:
The values of the Instance Type and RDS Instance ID parameters determine
which of the other parameters are displayed.

- Destination Database

- Instance Type: Select RDS Instance.

- Instance Region: Select the region where the original RDS instance is
located.

- RDS Instance ID: Select the ID of the original RDS instance.

- Database Account: Enter the username of the account for the original RDS
instance.

- Database Password: Enter the password of the account for the original RDS
instance.

- Connection: Select Non-encrypted. If the original RDS supports SS_ encryption

and has SSL encryption enabled, then you must selectSSL-encrypted.

Note:



The values of the Instance Type and RDS Instance ID parameters determine

which of the other parameters are displayed.

Source Database

RDS Instance v
China (Hangzhe

rm-1udgr8Buelel9i3x2 - RDS Instances of Other Apsara Stack Accounts

superuser_backup ‘
.................... @ ‘ Test Connectivity

* Non-encrypted S5L-encrypted

Destination Database

............. | 9@

Test Connectivity

®' Non-encrypted S5L-encrypted

5. Click Set Whitelist and Next.
6. Select Schema Migration and Full Data Migration next to Migration Types.
7. In the Available section, select the objects you want to migrate. Then click > to

move the selected objects to the Selected section.

Note:
DTS checks for objects that have the same name. If the destination RDS instance
has an object whose name is the same as the name of an object to be migrated,

the data migration fails.
In such case, take one of the following two operations:

- In the Selected section, move the pointer over the object whose name you
want to change, click Edit, and in the displayed dialog box enter the new

object name.
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- Rename the object in the destination RDS instance.

*  Migration Types: Schema Migration Full Data Migration [ ] Incremental Data Migration

During full data migration, data updates in the source database are not migrated to the destination instance.
For data consistency, we recommend that you select Schema Migration, Full Data Migration, and Incremental Data Migration.

fvailable Selected (To edit an object name or its filter, hov
Edit.) Leam maore.
If you search globally, please expand the Q,
gys

test0l

8. Click Precheck.

Issue: 20191127 147
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9. Optional. If the migration task fails the precheck, click next to the check

item whose Result is Failed, and resolve the problem according to the failure

information.

Pre-check

Pre-check failed 90%

Check item Check content Check result
Check database Check whether the database for target database F—
availability to be migrated in is available

Check whether account permissions for the
source database meet the requirements for Success
migration

Check source
database permission

Check whether account permissions for the
target database meet the requirements for Success
migration

Check target database
permission

Check whether there are any structure objects
having the same names with objects to be Failed
migrated in the target database

Check objects with the
same name

Cancel

148 Issue: 20191127
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100n the page that displays migration tasks, select the migration task you created,
then click Start.

Task ID/Name: | o Status: Passed

2019-08-08 11:00:57 Created

[]  Task ID/Name: Status: Migration Failed View Cause and Rectify

2019-08-02 13:54:11 Created

Incremental Data Migration The migration task is not delayed.

[]  Task ID/Name: Status: Migration Failed View Cause and Rectify

2019-08-02 13:52:14 Created

Incremental Data Migration The migration task is not delayed.

[[]  Task ID/Name: s - | = e el Status: Migration Failed View Cause and Rectify

2019-06-11 16:59:26 Created

Full ata Miration 100%igrat

[[]  Task ID/Name: s | Status: Migration Failed View Cause and Rectify

2019-06-11 16:21:38 Created

OGE]@) o e

11 When the migration task passes the precheck, click Next.

121In the Confirm Settings dialog box, confirm the configuration, select Data

Transmission Service (Pay-As-You-Go) Service Terms, and click Buy and Start.

Issue: 20191127 149



15 Disable the database proxy mode

This topic describes how to disable the database proxy mode for an RDS for PPAS
instance. Disabling the database proxy mode means switching to the standard

mode, which helps improve the performance of the RDS instance.

Notice:
The database proxy mode may cause service instability in certain circumstances.
For smooth service operation, we recommend that you upgrade the network
connection mode of your RDS instance as soon as possible. For more information,

see #unique 113.
Precautions

- In the database proxy mode, the multi-statement function is enabled by default
at the protocol layer. Therefore, after you disable the database proxy mode, if
you do not enable the multi-statement function but run multiple SQL statements,
the system reports errors in the SQL statements. To prevent this problem, you
must check and add connection parameters in advance. For example, you can

add the allowMultiQueries parameter to JDBC as follows:

dbc:mysql:///test?allowMultiQueries=true

- You can only disable the database proxy mode (that is, switch from the database
proxy mode to the standard mode). You cannot enable the database proxy mode (
that is, switch from the standard mode to the database proxy mode).

- Switching the access mode may cause a 30-second transient disconnection.
Therefore, we recommend that you switch the access mode during off-peak
hours or make sure that your application can automatically reconnect to the RDS

instance.
Prerequisites

The database proxy mode is enabled for your RDS instance.

Note:

- If the Database Proxy tab is displayed, the database proxy mode is enabled and

you can proceed with the operations described in this topic.



- If the Database Proxy tab is not displayed, the database proxy mode is not
displayed and you can skip this topic.

Accounts
ensparen: Switch Read/Write Splitting Persistent Connections Brute-force Attacks Protection
Databases

Backup and Restorati...

Database Connection

I Status

Monitoring and Alert... Database Proxy Status ") Enabled

Procedure

Method 1

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.
= () Alibaba Cloud  cvina tHancen Q  BlingMansgement Mo (I A @y Engish (0
RDS inst; oo
‘ApsaraDB for RDS
RDS Mal Learning Path Log On to DB < Refresh _
Cross-region Backup Basic Inf

Locked Instances (0)
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Instance & 2
VPC
- china P, .
30N ZoneH x You-Go
q china vee
Hangzho { weeze Pa‘j_c 0 an: Subscription Billing | More
ZoneH “

3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Database Connection.

5. Click Switch Access Mode and in the displayed dialog box, click Confirm.

Instance Connection | Read/Wiite Spliitting
I Database Connection How to connect to RDS @ Can't Connect?  Switch VSwitch  Switch to Classic Network
VPC (VPCivE ) Enabled
m- 3306

Note: Use the preceding connection string to connect to the instance. You need to change the VIP in the connection string to the one used in your environment.

E] Note:

This button is available only when you have enabled the database proxy mode.
Method 2

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/
https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
= () Alibaba Cloud  cnina tHangzhou « Q  BilingManagement More [ A ¢y Engish (0
ROS instz Europs stics. You can save data by OpenAP] for long-term queries. Ignore
ApsarabB for RDS
RDS M: L g O B T Refresh
Cross-region Backup gasic
Locked Instan [(

IR IEEEE

Japan (Tokyo)

3. Find the target RDS instance and click the instance ID.

4. In the left-side navigation pane, click Database Proxy.

5. On the Database Proxy tab, click the slider next to the database proxy status and
in the displayed dialog box, click Confirm.

E] Note:

This tab page is available only when you have enabled the database proxy mode.



16 Manage logs

This topic describes how to manage logs through the RDS console or by using SQL
statements. You can query error logs and slow query logs. The log query results

help you to locate faults. All RDS for PPAS instances support log management.

- For information about log backup policies and rules, see Back up the data of an RDS for

PPAS instance.

- For information about how to download log backup files, see Download the backup

files of an RDSfor PPASinstance.

- For information about how to restore data through log backup files, see Restore the

data of an RDSfor PPASinstance.
Procedure

1. Log on to the RDSconsole.

2. In the upper-left corner, select the region where the target RDS instance is

located.

u =) Alibaba Cloud e tarsan « Q st e B8 @ e (0
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3. Find the target RDS instance and click the instance ID.
4. In the left-side navigation pane, click Log Management.

5. On the Log Management page, select Error Log, Slow Query Log, Slow Query Log

Summary, or Primary/Secondary Instance Switch Log, select a time range, and

click Search.
Query item Description
Error Log Records the SQL statements that are failed to be
executed within the last one month.



https://rds.console.aliyun.com/

Query item

Description

Slow Query Log Records the SQL statements that lasted for more than
1 second within the last one month. Similar SQL
statements are displayed once only.

Primary/Secondary |Records logs related to the switchovers between the

Instance Switch Log

master and slave instances within the last one month.

Note:

For each RDS instance in the China (Zhangjiakou) region, the system retains

only the error logs, slow query logs, and slow query log summary generated

within the last nine days.




17 Tag

17.1 Create tags

This topic describes how to create tags for one or more RDS instances. If you have
a large number of RDS instances, you can create tags and then bind the tags to
the instances so that you can classify and better manage the instances. Each tag

consists of a key and a value.
Limits
- Up to 10 tags can be bound to each RDS instance, and each tag must have a
unique key. Tags with the same key are overwritten.
- You can bind up to five tags at a time.
- Tag information is independent in different regions.

- After you unbind a tag from an RDS instance, the tag is deleted if it is not bound

to any other RDS instance.
Procedure

1. Log on to the RDSconsole and in the left-side navigation pane, click Instances.

2. In the upper-left corner, select the region where the target RDS instance is

located.
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https://rds.console.aliyun.com/

3. Specify the method of adding tags.

- If you want to add tags to only one RDS instance, find the RDS instance and in

the Actions column choose More > Edit Tag.

- If you want to add tags to more than one RDS instance, select the RDS

instances and click Edit Tag

Instance Name 7 m W Tag

A
China i
v rm-1udycae74695n16d8 - Aug 26, 2019, Primary oo e [ VPC:vpe- Pay-s- [ cubecrnton Bl —
rm-1udycae74699n... # LD 16:18 Instance YSQL 5. ¢ EZ:‘]”’E:”' bplb8cddhh2bBOodday6  You-Go o anage | Subscription Biling
) Change Specification
Release Instance
China e
@ vm'lndglﬁfnﬂe@@ﬁx? Running Aru; 22, 2019, Primary MySQL 5.7 (Hangzhou) ) ‘IVPC‘VPf' . Pay-As- Restore Database (Previously Clone Database)
rm-1udgreBue1e09... 10:54 Instance : bp1b8cd4hh2biB90dd3y6  You-Go
9 ZoneH "
»
Cross-region Backup Settings
China e -
-1udinzb7781830y1 Aug 14, 2019, Primary . [ VPCivpe- Pay-s-
:Eﬂ::dj:iw?;ms..t ‘ Running 1:?45 T IQLT;“@ MysQL 5.7 ‘-HEZ:‘JHZE"‘:”:‘ it o Manage | Subscription Biling | More +

bp1b8cd4hh2bl89odd3ys  You-Go

Edit Tag Total: 3 item(s), Per Page: 30 item(s)

4. Click Add, enter the Key and Value, and click Confirm.

E] Note:

If you have already created tags, you can click Available Tags and select an

existing tag.

Edit Tags

Add: Available Tags Create

5. After you add all the tags you need, click Confirm.



APIs

API

Description

AddTagsToResource

Used to bind a tag to RDS instances.

17.2 Delete tags

This topic describes how to delete tags from an RDS instance when you no longer

need the tags or due to adjustments to the instance.

Limits

After you unbind a tag from an RDS instance, the tag is deleted if it is not bound to

any other instance.

Procedure

1. Log on to the RDSconsole and in the left-side navigation pane, click Instances.

2. In tne upper-left corner, select the region where the target RDS instance is

located.
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3. Find the target RDS instance and in the Actions column, choose More > Edit Tag.



https://rdsnew.console.aliyun.com/

4. Find the tag you want to delete, and click the X button following the tag.

Edit Tags

( System01:DBO1 ﬁ

Add: Available Tags Create

Cancel
5. Click Confirm.
APIls
API Description
#unique_119 Used to unbind a tag from an RDS
instance.

17.3 Filter RDS instances by tag

This topic describes how to filter RDS instances by tag.

1. Log on to the RDSconsole.


https://rds.console.aliyun.com/

2. In the upper-left corner, select the region where the target RDS instance is

located.
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ROS inste 252 P2
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3. On the Basic Information tab, click the Tag button next to Search and select a tag

key and a tag value.

@ Note:

You can click the X button following the tag key to cancel the filter operation.

Basic information Tags Performance
Instance name ﬂ Please enter instance ID for search
rdso0pl6vnwl2euabs2b Runni 2016-04-01
rdso0pl6vnwl2eua... unning ;5.5

APIls

- [

system01

PostgreSQL Singapore Classic Pay-as-  system02:db01 ,

o4 ZoneA yougo  systemOlbor  enege | More -

Regular

API

Description

DescribeTags

Used to query tags.
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